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1 HP Photosmart 概述

HP Photosmart 总览

编号 说明

1 彩色图形显示屏（也称显示屏）

2 控制面板

3 存储卡插槽和前端 USB 端口

4 出纸盒（当前所显示的为向上的位置）

5 照片纸盒

6 照片纸盒的纸张宽度导板

7 主进纸盒（也称主纸盒）

8 纸盒延长板（也称延长板）

9 墨盒门

10 USB 端口

11 电源接口*

12 后盖

* 只用于 HP 提供的电源适配器。

控制面板功能
以下图示和相关表格提供了 HP Photosmart 控制面板功能的快速参考。
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标签 图标 名称和描述

1  彩色图形显示屏（也称为显示屏）：显示菜单、照片和消息。显示屏可以立起来，成一定的角度放置，以便
获得更好的视觉效果。

2 帮助：打开显示屏上的帮助菜单，可以选择主题以了解其内容。在空闲状态下，按帮助将列出具有帮助信息
的各个项目的菜单。根据所选主题的不同，主题内容会显示在显示屏或您的计算机显示屏上。当在空闲状态
以外查看屏幕时，帮助按钮将提供上下文相关帮助。

3 红眼消除：打开或关闭红眼消除功能。默认情况下，此功能是打开的。打开此功能后，HP Photosmart 会自
动修复照片中的红眼。当红眼消除功能已打开且连接有存储卡或存储设备时，红眼消除指示灯会呈绿色常
亮。

4 设置：打开显示屏上的设置菜单，您可以在这里生成报告、更改设备设置以及执行维护功能。

5 打印照片：根据您是从“视图”、“打印”还是“创建”菜单访问照片，打印照片按钮将显示“打印预
览”屏幕或打印任何选定的照片。如果未选中任何照片，系统会询问您是否要打印存储卡或存储设备中的所
有照片。

6 取消：停止当前操作。

7 警示灯：表示出现问题。有关详细信息，请参阅显示屏。

8 后退：返回显示屏的上一屏幕。

9 主页：启动显示屏上的“Photosmart Express”菜单，以便查看、打印、编辑和保存照片。通
过“Photosmart Express”菜单，您还可以使用自己的照片创建特殊项目。

10 缩小 -：缩小以显示一张照片的更多部分。如果在以 100% 比例在显示屏上显示照片时按此按钮，则将应
用“适合页面”功能自动缩放照片以使其适合打印尺寸。

11 放大 +：放大显示以在显示屏上放大图像。您还可以将此按钮与方向键盘上的箭头组合使用，以调整裁剪框
进行打印。

12 OK：选择显示屏上的菜单设置、值或照片。

13 方向键：按上、下、左、右箭头按钮，可以导航照片和菜单选项。

如果正在放大照片，也可以使用箭头按钮来平移照片，然后选择不同的区域来进行打印。

14 开／关机：打开或关闭 HP Photosmart。产品开启时，开／关机灯呈蓝色常亮。当产品在使用中时，开／关
机灯会闪烁。

Photosmart Express 菜单
在插入存储卡或按控制面板上的主页按钮时，可使用“Photosmart Express”菜单中的下列选项。

“视图”
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• “视图”：您可以查看、编辑和打印存储卡上的照片。有关详细信息，请参阅位于第 8 页的“查看
并选择照片”。

• “打印”：您可以选择页面布局并打印照片。有关详细信息，请参阅屏幕帮助。要访问屏幕帮助，请
参阅位于第 12 页的“查找更多信息”。

• “创建”：您可以为自己的照片选择一个创意项目，比如相册、全景打印件和护照照片等。有关详细
信息，请参阅屏幕帮助。要访问屏幕帮助，请参阅位于第 12 页的“查找更多信息”。

• “保存”：您可以将存储卡里的照片直接保存到计算机上。有关详细信息，请参阅屏幕帮助。要访问
屏幕帮助，请参阅位于第 12 页的“查找更多信息”。

在首次显示“Photosmart Express”菜单时，会默认高亮显示“视图”。按 OK 进行选择。要选择其
他选项，请使用方向键盘上的箭头键高亮显示该选项，然后按 OK。

提示 屏幕箭头会显示在当前高亮显示的选项旁，可指示需要按下以导航至其他选项的箭头键。

纸张概述
HP Photosmart 打印机支持的纸张大小范围为 7.6 x 12.7 cm 到 33 x 111.8 cm，包括 B+（33 x 48.3 cm/
13 x 19 英寸）纸、letter 或 A4 纸、legal 纸、照片纸、透明胶片和信封。默认情况下，HP Photosmart
设置为自动检测您在进纸盒中放入的纸张尺寸和类型，然后调整其设置以生成对于该纸张而言最高质量
的输出。

如果使用了照片纸、投影胶片、信封或标签纸等特殊纸张，或者在应用自动设置时打印质量较差，则可
以手动设置打印作业的纸张尺寸和类型。

小心 请不要放入厚度超过 0.4 mm 的介质，因为它会损坏打印机。

选择正确的纸张
要获得可用的 HP 喷墨打印纸的列表，或是要购买耗材，请访问：

• www.hpshopping.com（美国）

• www.hp.com/eur/hpoptions（欧洲）

• www.hp.com/jp/supply_inkjet（日本）

• www.hp.com/paper（亚太地区）

要从打印机获得最佳和最持久的效果，请选择这些高质量的 HP 照片纸。

打印 使用这种纸张或介质

优质持久的打印件和扩印件 HP 高级照片纸（这种照片纸有多种纸面，包括光面和绒面／软
光面。并非所有的国家／地区都提供全部纸面种类的 HP 高级
照片纸，也并非每种纸张尺寸的 HP 高级照片纸都具有全部纸
面种类。）

打印头校准 普通纸

来自于电子邮件和 Web 的临时照片 HP 普通照片纸或普通纸

文本文档、草稿和测试页 普通纸

在主纸盒中放入纸张
您可以在 HP Photosmart 的主进纸盒中放入多种类型的纸张，其最大尺寸不得超过 33 x 111.8 cm。

向主纸盒中放入纸张

1. 同时抬起出纸盒和照片纸盒。

第 1 章
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2. 展开主纸盒以放入较大的纸张。

3. 将纸张宽度导板滑到最外侧。

4. 确保产品处于空闲状态，然后将一摞纸张放入主纸盒，短边朝前，打印面朝下。将这摞纸向里推入，
直至无法再推入。

提示 如果用的是信笺纸，请首先插入纸张顶端并将打印面朝下。

5. 向内滑动纸张宽度导板，直到它停靠在纸张的边缘处。

注意 确保纸摞的高度不超过纸张宽度导板。

纸张概述 5
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6. 如果展开了主纸盒，请将其推回到这摞纸张的边缘位置。

7. 同时放下照片纸盒和出纸盒，然后展开出纸盒。

在照片纸盒中放入纸张
可以将最大为 13 x 18 厘米的照片纸放入 HP Photosmart 的照片纸盒中。为了获得最佳效果，请使用
HP 高级照片纸。

向照片纸盒中放入纸张

1. 抬起出纸盒。

2. 将纸张宽度导板滑到最外侧。

3. 将一摞照片纸短边朝前、打印面朝下放到照片纸盒中，向前推入一直到不能移动为止。

提示 放入带裁边的照片纸时，裁边最后放入。

4. 向内滑动纸张宽度导板，直到它停靠在纸张的边缘处。

注意 确保纸摞的高度不超过纸张宽度导板。
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5. 放下出纸盒。

重要！请确保出纸盒已完全放下，否则照片纸盒可能无法正常工作。

避免卡纸
遵循以下操作规范可避免卡纸。

• 经常从出纸盒中取出已打印好的纸张。

• 将所有不使用的照片纸平放保存在密封包装中，以防其卷曲或起皱。

• 确保纸张平放在进纸盒中，并且边缘没有弯曲或撕裂。

• 如果您要打印标签，请确保标签纸未保存超过两年。当纸张通过产品时，旧纸上的标签可能会脱落，
造成卡纸。

• 不要在进纸盒中混用不同类型和尺寸的纸张；进纸盒中所有的纸张都必须尺寸、类型完全相同。

• 调整进纸盒中的纸宽导纸板，使其紧贴所有纸张。确保纸宽导纸板没有将进纸盒中的纸压弯。

• 不要将纸硬往进纸盒里推。

• 使用推荐用于本产品的纸张类型。

从存储卡和其他设备进行打印
HP Photosmart 配有存储卡插槽和正面 USB 端口，您可以从存储卡或存储设备（如便携式存储器、便携
式硬盘或处于存储模式的数码相机）打印或编辑照片，无须先将照片上传到计算机。另外，如果
HP Photosmart 通过 USB 电缆连接到计算机，您也可以把照片传到计算机上进行打印或编辑。

可以通过将与 PictBridge 兼容的数码相机直接连接到正面 USB 端口来打印照片。从数码相机打印时，
打印机会使用相机上选定的设置。有关详细信息，请参阅相机随附的文档。

插入存储卡或存储设备
HP Photosmart 支持如下所述的存储卡和存储设备。每种类型的存储卡只能插入该卡相应的插槽中，并
且每次只能插入一张存储卡或一台存储设备。

小心 切勿一次插入多张存储卡。如果插入了多张存储卡，可能会发生不可恢复的数据丢失。

从存储卡和其他设备进行打印 7

简
体
中

文



1 Memory Stick、Memory Stick Pro、Memory Stick Select、Memory Stick Magic Gate、Memory Stick Duo
或 Duo Pro（可选用适配器）、Memory Stick Micro（需要适配器）或 MS-HG

2 xD-Picture 卡、xD- Picture 卡 M 型、xD-Picture 卡 H 型、Secure Digital (SD)、Secure Digital Mini（需要适
配器）、SD micro（或 Transflash）、Secure Digital High Capacity (SDHC)、MultiMediaCard (MMC)、
MultiMedia High-Density (MMC-HD)、MMC Plus 或 MMC Mobile（RS-MMC；需要适配器）

3 CompactFlash (CF) I 型和 II 型

注意 不支持 IBM Microdrive。

4 “照片”灯

5 正面 USB 端口（适用于存储设备）

插入存储卡或连接照片存储设备

1. 确保打印机已启动。

2. 插入存储卡或将照片存储设备连接到正面 USB 端口。
存储卡区域有“照片”灯，在产品读取存储卡或存储设备时会闪烁。当此灯变为常亮时，您就可以查
看自己的照片了。

小心 请勿在照片指示灯闪烁时拔出存储卡。这样操作可能会损坏存储卡或产品本身。

注意 产品只能识别出存储卡或存储设备上的 JPG 和 TIF 文件格式。

查看并选择照片
可在打印存储卡或存储设备上的照片之前或在打印照片时，查看和选择这些照片。

查看并选择照片

1. 将最大尺寸为 13 x 18 cm 的照片纸装入照片纸盒，或将全尺寸照片纸装入主进纸盒。

2. 将存储卡插入相应插槽中，或将照片存储设备连接到正面 USB 端口。
将出现“Photosmart Express”菜单，并在显示屏上显示最新的照片且高亮显示“视图”。
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“视图”

“打印” “创建” “保存”

3. 按 OK 选择“视图”。
将显示“查看照片”屏幕。

4. 按  或  滚动浏览照片的缩略图。

5. 当您要查看的照片的缩略图高亮显示后，按 OK。

6. 当照片自动出现在显示屏上后，请再次按 OK。
将显示“照片选项”屏幕。

7. 高亮显示“打印预览”后，按 OK。
将显示“打印预览”屏幕，显示照片打印时的外观。

8. 如果要选择查看和打印其他照片，可按  高亮显示“添加更多”，按 OK，然后重复步骤 4‐6。
或者，在“添加照片”屏幕上，选择多个照片最快的方法（如果不需要编辑照片的选项）是按  选
择一个照片，然后按  或  滚动浏览多个照片以进行选择。

提示 将显示一个复选标记，指示选中的每个照片。按  或  可以更改份数。要打印的照片总数
显示在显示屏的顶部。

9.（可选）如果您要检查和／或修改任何打印设置，可按  高亮显示“设置”，然后按 OK。

10.要打印照片，请使用  或  高亮显示“立即打印”（或按控制面板上的打印照片按钮）。
打印状态屏幕将显示要打印的页数，以及估计完成时间。

提示 在打印过程中，可以按 OK 按钮以将更多照片添加到打印队列中。

打印照片
可以按多种尺寸（从 8 x 13 cm 到最大 33 x 48.3 cm 的纸张）打印存储卡或照片存储设备上的照片，包
括可以在一张纸上打印多张小尺寸照片。

打印照片

提示 要在 10 x 15 cm 大小的纸张上单独打印一张无边框的 10 x 15 cm 照片，仅需按两次控制面板
上的打印照片按钮即可。

1. 放入纸张。

• 在照片纸盒中放入的照片纸不得超过 13 x 18 cm 大小。

• 在主进纸盒中放入全尺寸的照片纸。

2. 插入存储卡或连接照片存储设备。

3. 确保“视图”突出显示，然后按 OK。

4. 使用箭头按钮选择照片，然后按 OK。

5. 按控制面板上的打印照片。

从存储卡和其他设备进行打印 9
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6. 按照打印机显示屏上的说明修改打印设置：

• 选择“立即打印”可以立即打印照片。

• 选择“添加更多”可以更改打印份数。

• 选择“设置”可以更改布局。

7. 按 OK 打印照片。

从 PictBridge 相机或其他 PictBridge 设备打印照片
本节说明从 PictBridge 数码相机进行打印的过程。从其他 PictBridge 设备（如可拍照手机和其他图形捕
获设备）进行打印的程序非常类似。请查阅 PictBridge 设备随附的文档以获取详细信息。

从数码相机打印时，打印机会使用相机上选定的设置。详细信息，请参阅相机随附的文档。

PictBridge 相机已连接到相机端口

使用 PictBridge 认证的相机进行打印

1. 在打印机中放入照片纸。

2. 打开 PictBridge 认证的数码相机。

3. 确保相机的 USB 配置被设为“数码相机”，然后使用 USB 电缆（PictBridge 认证相机附带的电缆）
将相机与打印机的相机端口连接起来。当相机与打印机建立连接时，“照片”灯呈绿色闪烁，然后呈
绿色常亮。
有关 USB 配置设置的详细信息，请参阅相机文档。非 HP 数码相机上的设置名称及其选项可能不同。

4. 如果在相机上已选中要打印的照片，那么相机中会显示“打印 DPOF 照片?”对话框。DPOF（数码
打印命令格式）可使用户将数码相机上的照片标记为打印，并可包含其他图像信息，如要打印的份
数。选择“是”可打印这些预选的照片，或选择“否”可跳过这些预选照片的打印。

5. 使用相机上的选项和控件打印照片。详细信息，请参阅相机文档。照片正在打印时，PictBridge 灯会
闪烁。

从计算机打印
任何具有打印功能的软件应用程序都可以使用 HP Photosmart。可以打印许多项目，如无边距图像、时
事通讯、贺卡、烫印转印和海报等。

从计算机打印为您提供了更多选项来打印图像。在从计算机打印之前，必须安装 HP Photosmart 软件并
用 USB 电缆将打印机（使用后面的 USB 端口）连接到计算机。

从软件程序中打印

从软件应用程序打印 (Windows)
1. 确保进纸盒中有纸。

2. 在软件程序的“文件”菜单中，单击“打印”。

3. 选择 HP Photosmart 作为打印机。
如果已经将 HP Photosmart 设置成默认的打印机，可以跳过这一步。将会自动选择 HP Photosmart。

第 1 章

10 HP Photosmart 概述

简
体
中

文



4. 如果需要更改设置，请单击按钮，打开“属性”对话框。
根据所使用的软件应用程序，该按钮可能叫作“属性”、“选项”、“打印机设置”、“打印
机”或“首选项”。

注意 当打印照片时，您必须选择特定的照片纸和图像增强选项。

5. 使用“打印快捷方式”、“功能”、“颜色”以及“高级”选项卡中提供的功能为打印作业选择合适
的选项。

提示 通过在“打印快捷方式”选项卡上选择一个预定义的打印任务，可以轻松地为打印作业选择
合适的选项。在“打印快捷方式”列表中，单击某种类型的打印任务。“打印快捷方式”选项卡
中包含此类型打印任务的默认设置和摘要。如有必要，您可以在此处调整设置并将自定义设置保
存为新的打印快捷方式。要保存自定义打印快捷方式，请选择此快捷方式并单击“另存为”。要
删除打印快捷方式，请选择此快捷方式并单击“删除”。

6. 单击“OK”关闭“属性”对话框。

7. 单击“打印”或“OK”开始打印。

从软件应用程序打印 (Mac OS X v10.4)
1. 从软件应用程序的“文件”菜单中，选择“页面设置”。

将出现“页面设置”对话框，可以在其中指定纸张大小、打印方向和缩放比例。

2. 确保选中 HP Photosmart 打印机。

3. 指定页面属性：

• 选择纸张大小。

• 选择打印方向。

• 输入缩放百分比。

4. 单击“OK”。

5. 从软件程序的“文件”菜单中，选择“打印”。
出现“打印”对话框，并且打开了“份数&页数”窗格。

6. 根据项目需要，在弹出式菜单中更改打印设置选项。

注意 打印照片时，必须为正确的纸张类型和照片增强选择选项。

7. 单击“打印”开始打印。

从软件应用程序打印 (Mac OS X v10.5)
1. 从软件应用程序的“文件”菜单中，选择“打印”。

将出现“打印”对话框。

2. 确保选中 HP Photosmart 打印机。

3. 单击“打印机”选项旁边的蓝色三角符以访问打印选项。

4. 指定页面属性：

• 选择纸张大小。

• 选择打印方向。

• 输入缩放百分比。

5. 要更改其他选项，如纸张类型，则从对话框底部的应用程序弹出式菜单中进行选择。

注意 打印照片时，必须为正确的纸张类型和照片增强选择选项。

6. 单击“打印”开始打印。

使用 HP 解决方案中心
HP 解决方案中心为使用 HP 设备和软件的许多功能提供了方便的途径。使用 HP 解决方案中心可以了解
打印机及其软件，并且查看疑难排解解决方案。

在计算机上安装 HP Photosmart 软件后，请如下打开并浏览 HP 解决方案中心：

从计算机打印 11
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▲ 右键单击 Windows 任务栏中的“HP 数字图像处理程序”图标，然后单击“启动／显示 HP 解决方
案中心”。

您还可以使用 HP 解决方案中心进行以下操作：

• 检查打印机状态并访问打印机“工具箱”以获取维护实用工具。

• 更改打印机设置。

• 订购耗材。

• 启动 HP Photosmart 软件。

• 更新打印机软件。

• 访问 HP 活动中心和 HP 专业摄影中心网站。

有关使用 HP 解决方案中心的详细信息，请参阅屏幕帮助。

您还可以从 HP 解决方案中心查看包含丰富信息的动画“如何操作？”：

▲ 在 HP 解决方案中心中，单击“帮助”，然后单击“动画库”区域的“打开动画库”。

查找更多信息
您可以访问在很多印刷和屏幕资源中提供的有关安装和使用 HP Photosmart 的信息。

• 《从这里开始》指南：《从这里开始》指南提供了有关安装 HP Photosmart 的说明，包括打印头安
装、插入墨盒、放入纸张和安装软件等内容。请务必按顺序执行《从这里开始》指南中的步骤。
如果在安装中遇到问题，请查询《从这里开始》指南中的疑难排解信息，或参阅
位于第 17 页的“疑难排解和支持”。

• HP Photosmart 动画：HP Photosmart 动画位于屏幕帮助的相关章节中，指导您如何完成
HP Photosmart 上的关键任务。您将了解到放入纸张、插入存储卡以及更换墨水的方法。

• 设备提供的帮助：使用显示屏上的帮助菜单可以快速访问主要的帮助主题，按帮助按钮之后也会出现
该项。在空闲状态下，按帮助将列出具有帮助信息的各个项目的菜单。根据所选主题的不同，主题内
容会显示在显示屏或您的计算机显示屏上。不在闲置状态下查看屏幕时，按帮助可提供上下文相关的
帮助。

• 屏幕帮助：屏幕帮助详细介绍了本手册中没有描述的 HP Photosmart 功能，包括那些只有在使用
HP Photosmart 随附的软件时才可用的功能。屏幕帮助还提供了产品规范和环境信息。
访问屏幕帮助

◦ Windows：单击“开始 > 所有程序 > HP > Photosmart B8500 series > 帮助”。
要安装屏幕帮助，请将软件 CD 插入计算机，然后按屏幕说明操作。

◦ Macintosh：单击“帮助 > Mac 帮助 > 库 > HP 产品帮助”。

• 自述文件：自述文件中含有可能在其他文档中无法找到的最新信息。
要访问自述文件，请安装软件。

• HP 网站：如果能访问 Internet，可以从 HP 网站 www.hp.com/support 获得帮助和支持。此网站提供
技术支持、驱动程序、耗材和订购信息。
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2 维护 HP Photosmart
只需要对 HP Photosmart 进行少许维护。您可能需要频繁地更换墨盒、清洁打印头或校准打印机。本节
提供了有关如何使 HP Photosmart 保持最佳工作状态的说明。根据需要执行下列简单维护步骤。

使用墨盒和打印头
为了确保 HP Photosmart 的最佳打印质量，需要执行一些简单的维护步骤；当显示屏上出现相应的提示
消息时，请更换墨盒。

有关墨盒和打印头的信息
下面的提示可以帮助您维护 HP 墨盒，确保稳定的打印质量。

• 在第一次安装时，请确保按照《从这里开始》指南中的说明安装打印头和墨盒。有关此产品所使用的
墨盒的信息，请参阅本指南封底内页的内容。

• 如果需要更换墨盒，请等到有新墨盒可供安装时再取下旧墨盒。

小心 请等待至有新墨盒可用时再取下旧墨盒。不要将墨盒长时间放在产品外部。这会对产品和墨
盒都造成损害。

• 将所有墨盒保存在原包装中，直到需要时再拿出来使用。

• 按产品上的开／关机按钮关闭 HP Photosmart。请等待至开／关机灯熄灭再拔出电源线或关闭电源
板。如果使用不正确的方法关闭 HP Photosmart，则墨盒托架可能无法回到正确的位置，从而引起墨
盒问题和打印质量问题。

• 在室温（15.6-26.6°C 或 60-78°F）下保存墨盒。

• 在打印质量变得不可接受前，您不必更换墨盒，但是如果出现打印质量显著下降，则可能是由于一个
或多个墨盒墨水耗尽。也可能是打印头阻塞。可能的解决方案包括查看墨盒中估计的剩余墨水量和清
洁打印头。清洁打印头将会使用一些墨水。

注意 墨水量警告和指示器所提供的估计墨水量信息只能用于计划用途。在收到墨水量不足的警告
消息时，请准备一个替换墨盒，以避免因缺墨可能导致的打印延误。如果打印质量可以接受，则
不需要更换墨盒。

• 不要进行不必要的打印头清洁。这会浪费墨水并缩短墨盒的使用寿命。

• 小心处理墨盒。安装期间，投掷、震动或草率处理墨盒可能会导致出现暂时打印问题。

• 如果要运输产品，请执行以下操作以防止墨盒中的墨水泄漏或对产品造成其他损坏：

◦ 确保按开／关机按钮关闭产品。
应该令墨盒停在维修舱的右侧。

◦ 确保安装好墨盒和打印头。

◦ 在产品内部装一些揉成团的报纸，以防止墨盒在运输过程中移动。

◦ 产品在运输时必须保持平放；不能使其边缘、背面、正面或顶部朝下放置。

检查预计的墨水量
可以轻松地查看墨水量，以确定多长时间后需要更换墨盒。墨水量表示墨盒中的估计剩余墨水量。

注意 1 如果安装了重新灌注或再生的墨盒，或者安装了在另一台打印机中用过的墨盒，墨水量指示
器可能不准确或不可用。

注意 2 墨水量警告和指示器所提供的估计墨水量信息只能用于计划用途。在收到墨水量不足的警告
消息时，请准备一个替换墨盒，以避免因缺墨可能导致的打印延误。如果打印质量可以接受，则不需
要更换墨盒。
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注意 3 墨盒中的墨水以多种不同方式用于打印过程，这些使用方式包括让产品和墨盒准备就绪的初
始化过程，还包括确保打印喷头清洁和墨水顺利流动的打印头维护过程。此外，墨盒用完后，其中还
会残留一些墨水。有关更多信息，请参阅 www.hp.com/go/inkusage。

有关墨盒估计产能的详细信息，请访问 www.hp.com/go/learnaboutsupplies。

从控制面板检查墨水量

1. 按设置。

2. 按向下箭头按钮以高亮显示“工具”，然后按 OK 按钮。

3. 按向下箭头按钮以高亮显示“显示墨水量”，然后按 OK 按钮。
产品上将显示一个计量图，指出所有已装入产品的墨盒中的估计墨水量。

提示 您还可以打印诊断页来了解是否需要更换墨盒。

更换墨盒
当需要更换墨盒时，请根据这些说明操作。

注意 如果是第一次设置产品，请确保按照《从这里开始》指南中的说明安装打印头和墨盒。

如果没有 HP Photosmart 的更换墨盒，要订购墨盒，请转到 www.hp.com/buy/supplies。如果出现提示
信息，请选择您的国家（地区），根据提示选择您的产品，然后单击页面上的某个购物链接。

注意 目前，HP 网站部分内容仅有英文版。

小心 请等待至有新墨盒可用时再取下旧墨盒。不要将墨盒长时间放在产品外部。这会对产品和墨盒
都造成损害。

更换墨盒

1. 确保打印机已经打开。

2. 打开墨盒检修门。

3. 等待墨盒停止移动。按下墨盒前面的卡销，然后将其从插槽中取出。
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4. 往回拉桔黄色的拉环，取下新墨盒的塑料包装。

注意 确保在产品中安装墨盒之前从墨盒上取下塑料包装，否则打印将失败。

5. 扭转桔黄色拉环帽，将其取下。

6. 将墨盒滑入相应插槽，然后将其下压直至卡入到位。

小心 安装墨盒时请勿提起墨盒上的闩锁柄。

7. 对于每个要更换的墨盒，重复步骤 3 到 6。
8. 关闭墨盒检修门。
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打印诊断页
如果出现打印问题，在更换墨盒前应先打印诊断页。此页可提供有关产品许多方面（包括墨盒）的有用
信息。

打印诊断页

1. 在主进纸盒中放入未使用的 letter、A4 或 legal 的普通白纸。

2. 按控制面板上的设置按钮。

3. 按  高亮显示“工具”，然后按 OK。

4. 按  高亮显示“诊断页”，然后按 OK。
此时产品将打印一份诊断页，其中包含以下信息：

• 产品信息：包括型号、序列号和其他产品信息。

• 版本信息：包括固件版本号。

• 供墨系统信息：显示每个已安装墨盒中的大概墨水量、每个墨盒的状态、每个墨盒的安装日期以
及每个墨盒的过期日期。

• 打印质量图案：显示五个色块，分别代表已安装的五个墨盒。实心的颜色均匀的色块表示没有打
印质量问题。当显示有条纹或色块缺失时，请清洁打印头。如果在清洁打印头后这些色块仍然显
示打印质量问题，则请校准打印机。有关清洁打印头和校准打印机的详细信息，请参阅屏幕帮
助。如果在清洁打印头和校准打印机后，这些色块仍然显示打印质量问题，请联系 HP 支持。

• 历史记录日志：所包含的信息在您致电 HP 支持进行故障诊断时可能有用。

关闭 HP Photosmart
为了避免损坏产品，必须使用产品上的开／关机按钮正确关闭它。请等待至开／关机灯熄灭再拔出电源
线或关闭电源板。
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3 疑难排解和支持
本章包含有关 HP Photosmart 的疑难排解信息。另外，还提供了有关安装和配置问题的详细信息，以及
一些操作方面的主题。有关疑难排解的详细信息，请参阅软件随附的屏幕帮助。有关访问屏幕帮助的详
细信息，请参阅位于第 12 页的“查找更多信息”。

如果在安装 HP Photosmart 软件之前就通过 USB 电缆将 HP Photosmart 连接到计算机，则会出现很多
问题。如果在软件安装屏幕出现提示之前就将 HP Photosmart 与计算机相连，则必须执行以下步骤：

排除常见安装问题

1. 从计算机上拔下 USB 电缆。

2. 卸载软件（如果软件已安装）。

3. 重新启动计算机。

4. 关闭 HP Photosmart，等候一分钟，然后重新启动。

5. 重新安装 HP Photosmart 软件。

小心 在软件安装屏幕提示您连接 USB 电缆之前，不要将电缆连接到计算机上。

有关支持联系信息，请参阅本手册封底内页。

卸载并重新安装软件
如果安装不完全，或者在软件安装屏幕出现提示之前就将 USB 电缆连接到了计算机，则可能需要卸载然
后重新安装软件。不要只是简单地从计算机中删除 HP Photosmart 应用程序文件。一定要使用安装
HP Photosmart 随附软件时提供的卸载工具进行正确卸载。

卸载软件并重新安装 (Windows)
1. 在 Windows 任务栏上，单击“开始”、“设置”、“控制面板”（或直接单击“控制面板”）。

2. 双击“添加／删除程序”（或单击“卸载程序”）。

3. 删除与 HP Photosmart 软件相关的所有项目。

小心 如果计算机由 HP 或 Compaq 制造，请不要删除除下面所列之外的任何应用程序。

• HP Photosmart、Officejet、Deskjet（带有产品名称和软件版本号）

• HP 解决方案中心

• 购买 HP 耗材

• HP 更新

• HP 图像处理设备功能

• HP Photosmart Essential
• HP 客户参与计划

• HP 智能 Web 打印

• Yahoo！工具栏

4. 断开产品和计算机的连接。

5. 重新启动计算机。

注意 重新启动计算机前，一定要断开产品的连接。重新安装完软件后，再将产品连接到计算机
上。

6. 将产品的 CD-ROM 插入计算机的 CD-ROM 驱动器，然后启动安装程序。

注意 1 如果未出现安装程序，请在 CD-ROM 驱动器上找到 Setup.exe 文件并双击。

注意 2 如果尚未购买安装 CD，您可以通过 www.hp.com/support 下载该软件。

7. 按照屏幕说明和产品随附的《从这里开始》指南中提供的说明进行操作。

软件安装完成后，“HP Digital Imaging Monitor”图标将出现在 Windows 系统任务栏中。
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卸载软件并重新安装 (Mac)
1. 断开 HP Photosmart 与 Mac 的连接。

2. 连按“应用程序”：“Hewlett-Packard”文件夹。

3. 连按“HP Uninstaller”。
根据屏幕上的说明执行操作。

4. 卸载完软件后，重新启动计算机。

5. 要重新安装软件，请将 HP Photosmart 的 CD-ROM 放入计算机的 CD-ROM 驱动器中。

6. 在桌面上打开 CD-ROM，然后连按“HP Installer”。

7. 遵循 HP Photosmart 随附的屏幕说明和印刷版安装说明。

设置疑难排解
本节包含有关产品安装的疑难排解信息。

产品无法开启

如果打开产品时没有指示灯亮、没有声音，没有动作，请尝试以下解决方案。

• 解决方案 1：确保使用产品随附的电源线

• 解决方案 2：重置产品

• 解决方案 3：请缓慢地按下开／关机按钮

• 解决方案 4：联系 HP 以更换电源适配器

• 解决方案 5：联系 HP 支持以进行维修

解决方案 1：确保使用产品随附的电源线

解决方法

• 确保电源线紧紧地连接到该产品和电源适配器上。将电源线插到电源插座、电涌保护器或电源插
线板上。

1 电源接头

2 电源线和适配器

3 电源插座

• 如果使用接线板，请确保接线板的开关已打开。或尝试将该产品电源线直接插入电源插座。

• 测试电源插座，确保其工作正常。插上一台可正常工作的设备，看设备是否有电。如果没电，则
电源插座可能有问题。

• 如果将该产品插入到带开关的插座中，请确保该插座开关已打开。如果将开关转到打开后仍然不
工作，则可能是电源插座存在问题。

原因: 该产品未使用随附的电源线。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 2：重置产品

解决方法: 通过断开电源线关闭该产品并重置。等待 60 秒钟，然后再次连接电源线。启动产品。
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原因: 产品出现错误。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：请缓慢地按下开／关机按钮

解决方法: 如果按下开／关机按钮的速度过快，则产品可能会没有响应。按一下开／关机按钮。产
品开启可能需要几分钟。如果此时再次按开／关机按钮，可能会将产品关闭。

小心 如果产品仍无法启动，则可能存在机械故障。切断产品的电源连接。

与 HP 支持部门联系进行维修。

请访问：www.hp.com/support。如果出现提示信息，请选择您所在的国家（地区），然后单
击“联系 HP”以获得联系技术支持的信息。

原因: 您按开／关机按钮的速度太快了。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 4：联系 HP 以更换电源适配器

解决方法: 联系 HP 支持人员索要产品的电源。

请访问：www.hp.com/support。

如果出现提示信息，则请选择您所在的国家／地区，然后单击“联系 HP”以获得有关请求技术支持
的信息。

原因: 电源适配器不适用于此产品。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 5：联系 HP 支持以进行维修

解决方法: 如果已经完成了前面解决方案中列出的所有步骤，但仍有问题，则请与 HP 支持部门联
系进行维修。

请访问：www.hp.com/support。

如果出现提示，则请选择您的国家／地区，然后单击“联系 HP”以获得技术支持。

原因: 您可能需要帮助才能使产品或软件正常工作。

我连接了 USB 电缆，但通过计算机使用产品时遇到了问题

解决方法: 连接 USB 电缆之前，必须先安装产品随附的软件。在安装过程中，除非屏幕说明提示您
插入 USB 电缆，否则请不要将其插入。

安装完软件之后，就可以直接使用 USB 电缆将计算机连接到打印机。只需将 USB 电缆的一端插入
计算机背面，将另一端插入本产品背面。可以连接到计算机上任一 USB 端口。
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有关安装软件和连接 USB 电缆的详细信息，请参阅产品随附的《从这里开始》指南。

原因: 安装软件前已连接 USB 电缆。在看到提示前就连接 USB 电缆会导致出错。

产品经过设置后却不打印

尝试使用以下解决方案解决该问题。解决方案是按照顺序列出的，可能性最高的解决方案放在最前面。
如果第一个解决方案无法解决问题，则继续尝试其他的解决方案，直到问题得以解决。

• 解决方案 1：检查产品和计算机之间的连接

• 解决方案 2：检查墨盒安装是否正确以及其中是否有墨水

• 解决方案 3：按下开／关机按钮，启动产品

• 解决方案 4：将纸张放入进纸盒中

解决方案 1：检查产品和计算机之间的连接

解决方法: 检查产品和计算机之间的连接。

原因: 产品和计算机不能互相通信。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 2：检查墨盒安装是否正确以及其中是否有墨水

解决方法: 检查墨盒安装是否正确以及其中是否有墨水。

详细信息，请参阅：

• 位于第 13 页的“使用墨盒和打印头”

原因: 其中一个或多个墨盒可能有问题。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：按下开／关机按钮，启动产品

解决方法: 查看产品上的显示屏。如果显示屏上没有任何显示，且开／关机按钮不亮，则说明产品
尚未启动。确保电源线牢固地连接到产品，且插入电源插座中。按开／关机按钮打开产品。

原因: 产品可能尚未启动。

如果这样无法解决问题，请尝试下一个解决方案。
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解决方案 4：将纸张放入进纸盒中

解决方法: 在进纸盒中装入纸张。

详细信息，请参阅：

• 位于第 4 页的“纸张概述”

原因: 产品可能缺纸。

将 CD-ROM 插入计算机的 CD-ROM 驱动器中时，没有任何反应

解决方法: 如果安装没有自动运行，可以手动开始安装。

从 Windows 计算机启动安装

1. 从 Windows“开始”菜单，单击“运行”（或单击“附件”，然后单击“运行”）。

2. 在“运行”对话框中，输入“d:\setup.exe”，然后单击“确定”。
如果 CD-ROM 驱动器未指定驱动器盘符 D，请输入相应的驱动器盘符。

原因: 安装程序无法自动启动。

出现最低系统检查屏幕

解决方法: 单击“详细信息”以查看具体原因，然后解决问题并尝试重新安装软件。

原因: 您的系统不符合安装软件的最低要求。

USB 连接提示窗口中出现一个红色的 X
解决方法: 确定产品已打开，然后再次尝试 USB 连接。

重试 USB 连接

1. 确认 USB 电缆连接正确：

• 拔下 USB 电缆，然后重新插入，或者尝试将 USB 电缆插入其他 USB 端口。

• 请勿将 USB 电缆连接到键盘。

• 确保 USB 电缆的长度不超过 3 米。

• 如果有多个 USB 设备与计算机相连，则在安装过程中可能需要拔掉其他设备。

2. 拔下产品的电源线，然后重新插入。

3. 确认 USB 电缆和电源线已插好。

4. 单击“重试”重试该连接。

5. 继续安装，出现提示后重新启动计算机。

原因: 产品与计算机之间的 USB 连接失败。
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清除卡纸
如果发生卡纸，请检查后盖。可能需要从后盖清除卡纸。

从后门清除卡纸

1. 从产品上拉开后盖，将其卸下。

2. 慢慢地将纸从滚筒里拉出来。

小心 如果从滚筒中取出纸张时纸张撕裂，请检查滚筒和齿轮，确定是否有破碎的纸片残留在产品
中。如果不从产品中取出所有纸片，可能会发生更多的卡纸。

3. 重新装上后门。轻轻地向前推后门，直到其卡住。

4. 按控制面板上的 OK 继续当前作业。

打印疑难排解
通过本节可解决下列打印问题。

产品不响应

尝试使用以下解决方案解决该问题。解决方案是按照顺序列出的，可能性最高的解决方案放在最前面。
如果第一个解决方案无法解决问题，则继续尝试其他的解决方案，直到问题得以解决。

• 解决方案 1：启动产品

• 解决方案 2：将纸张放入进纸盒中

• 解决方案 3：选择正确的打印机

• 解决方案 4：检查打印机驱动程序状态

• 解决方案 5：等待至产品完成当前操作为止

• 解决方案 6：从队列中删除所有已取消的打印作业

• 解决方案 7：清除卡纸

• 解决方案 8：确保墨盒可以自由移动。

• 解决方案 9：检查产品到计算机的连接

• 解决方案 10：重置产品

解决方案 1：启动产品

解决方法: 查看产品上的开／关机指示灯。如果它不亮，则产品已关闭。确保电源线牢固地连接到
产品，且插入电源插座中。按开／关机按钮打开产品。

原因: 该产品已关闭。

如果这样无法解决问题，请尝试下一个解决方案。
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解决方案 2：将纸张放入进纸盒中

解决方法: 在进纸盒中放入纸张。

详细信息，请参阅：

• 位于第 4 页的“纸张概述”

原因: 产品缺纸。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：选择正确的打印机

解决方法: 确保在软件应用程序中选择了正确的打印机。

提示 可以将本产品设为默认打印机，以确保在不同软件程序的“文件”菜单中选择“打印”时都
会自动选中它。

原因: 此产品不是所选的打印机。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 4：检查打印机驱动程序状态

解决方法: 打印机驱动程序的状态可能已经更改为脱机或停止打印。

检查打印机驱动程序的状态 (Windows)
▲ 打开 HP 解决方案中心。确保本产品是选定的打印机。有关打开 HP 解决方案中心的信息，请参

阅位于第 11 页的“使用 HP 解决方案中心”。
单击 HP 解决方案中心窗口底部的“状态”图标。

检查打印机驱动程序的状态 (Mac OS X v10.4)
1. 在 Finder 中，单击“应用程序”，单击“实用程序”，然后单击“打印机设置实用程序”。

2. 单击打印机名称以显示打印队列。

3. 单击打印作业将它选取。
使用下列按钮来管理打印作业：

• “删除”：取消选取的打印作业。

• “暂停”：暂停选取的打印作业。

• “恢复”：继续执行暂停的打印作业。

• “停止作业”：暂停打印队列中所有的打印作业。

检查打印机驱动程序的状态 (Mac OS X v10.5)
1. 在“系统首选项”中，单击“打印和传真”。

2. 单击“打开打印队列”按钮。

3. 单击打印作业将它选取。
使用下列按钮来管理打印作业：

• “删除”：取消选取的打印作业。

• “暂停”：暂停选取的打印作业。

• “恢复”：继续执行暂停的打印作业。

• “暂停打印机”：暂停打印队列中所有的打印作业。

原因: 打印机驱动程序的状态已更改。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 5：等待至产品完成当前操作为止

解决方法: 如果产品正在执行其他任务，如打印照片或执行打印机维修，则您的打印作业将被推迟
到产品完成当前任务为止。
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有些文档需要花很长时间打印。如果将打印作业发送到产品后经过几分钟仍然没有反应，请查看产品
显示屏中是否有错误消息。

原因: 产品正忙于执行其他任务。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 6：从队列中删除所有已取消的打印作业

解决方法: 打印作业取消后，可能仍会留在队列中。已取消的打印作业将堵塞队列，阻止打印下一
打印作业。

删除打印作业 (Windows)
1. 在 Windows 任务栏中，单击“开始”，然后单击“控制面板”。

2. 单击“打印机”（或双击“打印机和传真”）。

注意 在 Windows Vista 中，如果您未将“控制面板”设置为“经典视图”，则可能需要首先
选择“硬件和声音”。

3. 双击产品图标。

提示 也可以双击 Windows 任务栏上的打印机图标。

4. 选择要取消的打印作业。

5. 在“文档”菜单中，选择“取消打印”或“取消”，或按键盘上的 Delete。
取消打印作业可能需要一小段时间。

如果打印作业仍在队列中，则尝试执行以下一种或两种操作：

• 将 USB 电缆从产品断开，重新启动计算机，然后重新将 USB 电缆连接到产品。

• 关闭产品，重新启动计算机，然后重新启动产品。

删除打印作业 (Mac OS X v10.4)
1. 在 Finder 中，单击“应用程序”，单击“实用程序”，然后单击“打印机设置实用程序”。

2. 单击打印机名称以显示打印队列。

3. 单击打印作业将它选取。

4. 单击“删除”。

删除打印作业 (Mac OS X v10.5)
1. 在“系统首选项”中，单击“打印和传真”。

2. 单击“打开打印队列”按钮。

3. 单击打印作业将它选取。

4. 单击“删除”。

原因: 队列中有已删除的打印作业。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 7：清除卡纸

解决方法: 清除卡纸。

原因: 产品卡纸。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 8：确保墨盒可以自由移动

解决方法: 如果电源线尚未拔下，则拔下电源线。查看墨盒托架能否自由地从打印机的一端移至另
一端。如果托架被卡住，请勿用力推动。

小心 请勿用力推动墨盒托架。如果托架被卡住，用力推动托架将损坏打印机。
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原因: 墨盒托架被卡。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 9：检查产品到计算机的连接

解决方法: 检查产品和计算机之间的连接。确认 USB 电缆已牢固地插入产品背面的 USB 端口中。
确保 USB 电缆的另一端插入了计算机的 USB 端口中。正确连接电缆后，关闭产品，然后将其重新
打开。

如果连接正常，但在将打印作业发送到产品后经过几分钟还没有打印任何内容，请检查产品的状态。

原因: 计算机无法与产品通信。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 10：重置产品

解决方法: 通过断开电源线关闭该产品并重置。等待 60 秒钟，然后再次连接电源线。启动产品。

原因: 产品出现错误。

不从进纸盒进纸

尝试使用以下解决方案解决该问题。解决方案是按照顺序列出的，可能性最高的解决方案放在最前面。
如果第一个解决方案无法解决问题，则继续尝试其他的解决方案，直到问题得以解决。

• 解决方案 1：重置产品

• 解决方案 2：确保正确放入了纸张

• 解决方案 3：检查打印设置

• 解决方案 4：清洁滚筒

• 解决方案 5：产品送修

解决方案 1：重置产品

解决方法: 通过断开电源线关闭该产品并重置。等待 60 秒钟，然后再次连接电源线。启动产品。

原因: 产品出现错误。

如果这样无法解决问题，请尝试下一个解决方案。
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解决方案 2：确保正确放入了纸张

解决方法: 确保纸张已正确放入进纸盒中。

详细信息，请参阅：

• 位于第 4 页的“纸张概述”

原因: 未正确放入纸张。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：检查打印设置

解决方法: 检查打印设置。

• 检查纸张类型设置，以确保它与放入进纸盒中的纸张类型相匹配。

• 如果您要从计算机打印，请确保已在打印机驱动程序的“纸张来源”(Windows) 或 “来源”(Mac)
设置中设置了正确的纸盒。

有关详细信息，请参阅屏幕帮助。

原因: 纸张类型或打印质量设置不正确。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 4：清洁滚筒

解决方法: 清洁滚筒。

确保准备好以下物品：

• 不起毛布，或者不易撕裂或留下纤维的任何柔软材料。

• 蒸馏水、过滤水或瓶装水（自来水可能含有污染物，会损坏墨盒）。

清洁滚筒

1. 关闭此打印机，断开电源线。

2. 将后盖的左侧向外拉出，将其从产品上卸下。

3. 将不起毛的布浸泡到纯净水或蒸馏水中，然后挤干里面多余的水份。

4. 清洁橡胶滚筒，清除所有灰尘或脏的堆积物。

5. 更换后盖。轻轻地向上推后盖，直到其扣合到位。

6. 重新插入电源线，然后打开此打印机。

7. 再次尝试进行打印。

原因: 滚筒脏了，需要清洁。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 5：产品送修

解决方法: 如果已经完成了前面解决方案中列出的所有步骤，则请联系 HP 支持进行维修。

请访问：www.hp.com/support.

出现提示时，请选择您所在的国家／地区，然后单击“联系 HP”以获得有关请求技术支持的信息。
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原因: 您的产品需要维修。

产品打印出无意义的字符

尝试使用以下解决方案解决该问题。解决方案是按照顺序列出的，可能性最高的解决方案放在最前面。
如果第一个解决方案无法解决问题，则继续尝试其他的解决方案，直到问题得以解决。

• 解决方案 1：重置产品

• 解决方案 2：打印一份上次保存的文档版本

解决方案 1：重置产品

解决方法: 通过断开电源线关闭该产品并重置。等待 60 秒钟，然后再次连接电源线。启动产品。

原因: 产品中无可用内存。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 2：打印一份上次保存的文档版本

解决方法: 用同一软件程序打印其他文档。如果一切正常，请打印以前保存的、尚未损坏的文档。

原因: 文档已损坏。

打印出的文档的页面顺序错误

解决方法: 以相反的顺序印刷版文档。打印结束后，文档的页面顺序正确。

原因: 将打印设置设为首先打印文档的第一页。由于产品的送纸方式，第一页将打印面朝上位于纸
摞的底部。

文字或图像在页边处被裁去

尝试使用以下解决方案解决该问题。解决方案是按照顺序列出的，可能性最高的解决方案放在最前面。
如果第一个解决方案无法解决问题，则继续尝试其他的解决方案，直到问题得以解决。

• 解决方案 1：检查页边距设置

• 解决方案 2：检查文档的布局

• 解决方案 3：正确放入纸张

• 解决方案 4：尝试带边框打印

解决方案 1：检查页边距设置

解决方法: 确保文档的页边距设置没有超出产品的可打印区域。

检查页边距设置

1. 将打印作业发送到产品之前先预览一遍。
在多数软件应用程序中，单击“文件”菜单，然后单击“打印预览”。

2. 检查页边距。
只要比产品支持的最小页边距大，产品就使用您在软件程序中设置的页边距。有关在软件应用程
序中设置页边距的详细信息，请参阅软件随附的文档。

3. 如果页边距不符合要求，请取消打印作业，然后在软件程序中进行调整。

原因: 没有在软件程序中正确设置页边距。

如果这样无法解决问题，请尝试下一个解决方案。
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解决方案 2：检查文档的布局

解决方法: 确保要打印的文档的布局适合产品所支持的纸张尺寸。

预览打印布局 (Windows)
1. 在进纸盒中放入尺寸正确的纸张。

2. 将打印作业发送到产品之前先预览一遍。
在多数软件应用程序中，单击“文件”菜单，然后单击“打印预览”。

3. 检查文档中的图像，确保当前尺寸没有适合产品的可打印区域。

4. 如果图像超出页面的可打印区域，请取消打印作业。

预览打印布局 (Mac)
1. 在进纸盒中放入尺寸正确的纸张。

2. 打开“打印机”对话框。

3. OS X v10.5：单击“打印机”选项旁边的蓝色三角符以访问打印选项。

4. 在 OS X v10.5 中文档预览显示在对话框的左侧。

5. 在 OS X v10.4 中单击“预览”。
显示所打印文镐的预视。

6. 执行以下操作之一：

• 单击“打印”以打印文档。

• 单击“取消”以取消打印作业。再次打印文档前，按照需要调整打印设置值。

提示 一些软件程序允许对文档进行缩放以适应当前选择的纸张尺寸。另外，也可以从打印“属
性”对话框对文档进行缩放。

原因: 正在打印的文档尺寸大于进纸盒中放入的纸张。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：正确放入纸张

解决方法: 如果进纸有问题，可能会导致部分文档内容丢失。

从进纸盒中取出纸摞，然后重新放入纸张。

详细信息，请参阅：

• 位于第 4 页的“纸张概述”

原因: 未正确放入纸张。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 4：尝试带边框打印

解决方法: 通过关闭无边框选项，尝试带边框打印。

原因: 启用了无边框打印。通过选择“无边框”选项，所打印的照片将被放大并居中，以适合页面
的可打印区域。根据数码照片和正在打印的纸张的相对尺寸，这可能会使图像的某些部分被裁剪。

打印照片时，墨水喷洒到产品的内部

解决方法: 在进行无边框打印作业之前，请确保在进纸盒中放入了照片纸。

原因: 您正在使用错误的纸张类型。无边框打印设置要求您在照片纸上打印。

产品打印速度缓慢。

如果产品打印速度非常缓慢，请尝试以下解决方案。

• 解决方案 1：使用较低打印质量的设置
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• 解决方案 2：检查墨水量

• 解决方案 3：联系 HP 支持人员

解决方案 1：使用较低打印质量的设置

解决方法: 检查打印质量设置。“最佳”和“最大 dpi” 模式提供最佳打印质量，但是速度比“一
般”或“草图”模式要慢。“草图”模式提供最快的打印速度。

有关详细信息，请参阅屏幕帮助。

原因: 打印质量设置太高。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 2：检查墨水量

解决方法: 检查墨盒中的估计墨水量。墨水量不足可能会引起打印头过热。打印头过热时，打印机
的打印速度就会放慢，以使其冷却。

注意 墨水量警告和指示器所提供的估计墨水量信息只能用于计划用途。在收到墨水量不足的警告
消息时，请准备一个替换墨盒，以避免因缺墨可能导致的打印延误。如果打印质量可以接受，则
不需要更换墨盒。

有关详细信息，请参阅：

• 位于第 13 页的“检查预计的墨水量”

原因: 墨盒中可能墨水不足。

如果这样无法解决问题，请尝试下一个解决方案。

解决方案 3：联系 HP 支持人员

解决方法: 与 HP 支持部门联系进行维修。

请访问：www.hp.com/support.

如果出现提示信息，则请选择您所在的国家／地区，然后单击“联系 HP”以获得有关请求技术支持
的信息。

原因: 产品出现问题。

支持程序
如果遇到问题，请执行以下步骤：

1. 查阅产品随附的文档。

2. 访问 HP 的在线支持网站：www.hp.com/support。所有 HP 用户均可获取 HP 在线支持。在这里可以
迅速获取最新设备信息和专家帮助，其包含以下功能：

• 快速访问有资质的在线支持专家

• 产品的软件更新和驱动程序更新

• 贵重产品和常见问题的疑难排解信息

• 注册产品后可以获取主动设备更新、支持提醒以及 HP 新闻简报

3. 联系惠普支持。支持选项和可用性因设备、国家／地区和语言的不同而有所不同。
有关支持的电话号码列表，请参阅本指南封底内页的内容。
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4 技术信息
本节提供了有关 HP Photosmart 的技术规格以及国际规范信息。

有关其他规定和环境信息，包括《符合性声明》，请参阅屏幕帮助。

系统要求
下表列出了与打印机一起使用的计算机所需具备的最低要求。

组件 Windows Mac

操作系统 Microsoft® Windows XP 或 Vista（32 位或 64 位）

注意 只有有限的打印机软件功能（仅包含打印驱动程
序和打印机“工具箱”应用程序）可用于 Windows XP
x64 Edition。

Mac OS X v10.4、v10.5

处理器 1 GHz 32 位或 64 位现代处理器（建议使用 2 GHz 或
更高）

基于 G3、G4、G5 或 Intel 内核处理器的 PowerPC

RAM 对于 Windows XP 和 Windows Vista Home 版本：512
MB（建议使用 1GB 或更高）

所有其他版本的 Windows Vista：1 GB（建议使用 2
GB 或更高）

256 MB（推荐使用 512 MB）

可用硬盘空间 对于 Windows XP：800 MB
对于 Windows Vista：1.5 GB

500 MB

视频显示器 16 位彩色 SVGA 800 x 600 显示器（推荐使用 32 位彩
色 SVGA 1024 x 768 显示器）

1024 x 720 显示器

CD-ROM 或
DVD-ROM
驱动器

必需 必需

USB USB 端口和 USB 电缆（不包括电缆） USB 端口和 USB 电缆（不包括电缆）

Internet 访问 推荐 推荐

软件 必需：Microsoft Internet Explorer 6 或更高版本

建议：Adobe Acrobat Reader 5 或更高版本

任意浏览器

产品规格
有关产品规格的信息，请访问 HP 网站：www.hp.com/support。

纸张规格

• 主进纸盒容量：普通纸：最多 125 张照片纸：最多 40 张
• 出纸盒容量：普通纸：最多 50 张照片纸：最多 25 张
• 照片纸盒容量：照片纸：最多 20 张

注意 有关受支持介质的尺寸的完整列表，请参阅打印机软件。

物理规格

• 高度：184 mm（7.25 英寸）

• 宽度：578 mm（22.75 英寸）

• 长度：394 mm（15.5 英寸）

• 重量：7.5 kg（16.6 磅）

电源规格

• 耗电量（平均）：14 W（打印）；3 W（闲置）；0.48 W（关闭）

• 电源适配器型号：0957-2230
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• 电源适配器额定输入：AC 100-240 V，50‐60 Hz
• 电源适配器额定输出：DC 32 V

注意 只使用 HP 提供的电源适配器。

环境规格

• 推荐的工作温度范围：15℃-35℃
• 允许的工作温度范围：5℃-40℃
• 湿度：20%-80% 相对湿度（推荐）；5%-99% 相对湿度（最大）；

• 不工作（存储）时的温度范围：-30℃-65℃
• 在电磁场强的区域，HP Photosmart 的打印结果可能会稍微变形

• HP 建议使用长度不超过 3 米的 USB 电缆，以便将因潜在电磁场所导致的注入噪音降至最低

规范声明
HP Photosmart 符合您所在国家／地区的产品规范要求。有关规范声明的完整列表，请参阅屏幕帮助。

标准型号

为了便于识别，为产品指定了一个“标准型号”。本产品的标准型号为 SDGOA-0821。不要将此标准型
号与产品的市场名称（如 HP Photosmart B8500 series 等）或产品编号（如 CB981A 等）相混淆。

环保产品管理计划
有关环保产品管理计划的详细信息，请参阅软件随附的屏幕帮助。有关访问屏幕帮助的详细信息，请参
阅位于第 12 页的“查找更多信息”。

化学物质

HP 根据 REACH (Regulation EC No 1907/2006 of the European Parliament and the Council) 等法
律要求，向客户提供有关我们产品中的化学物质的信息。有关本产品的化学信息报告可以在以下网站中
找到：www.hp.com/go/reach。

墨盒保修信息
HP 墨盒保修只适用于产品在指定 HP 打印设备上使用的情况。此保修不涵盖重新灌注、再制造、翻新、
使用不当或擅自改动的 HP 墨水产品。

在保修期间产品均可得到保修，时间为 HP 墨水用完之前和保修期到期日期之前。保修期的到期日期格
式是 YYYY/MM/DD（年／月／日），可以按如下指示在产品上找到：

有关“HP 有限保修声明”的副本，请参阅产品随附的印刷版文档。
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1 HP Photosmart overview
The HP Photosmart at a glance

Label Description

1 Color graphics display (also referred to as the
display)

2 Control panel

3 Memory card slots and front USB port

4 Output tray (currently shown in the up position)

5 Photo tray

6 Paper-width guide for the photo tray

7 Main input tray (also referred to as the main tray)

8 Paper tray extender (also referred to as the tray
extender)

9 Ink cartridge door

10 USB port

11 Power connection*

12 Rear door

* Use only with the power adapter supplied by HP.

Control panel features
The following diagram and related table provide a quick reference to the HP Photosmart control panel features.
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Label Icon Name and Description

1  Color graphics display (also referred to as the display): Displays menus, photos, and messages. The
display can be pulled up and angled for better viewing.

2 Help: Opens the Help menu on the display where you can select a topic to learn more about it. From the
Idle state, pressing Help lists a menu of items for which help is available. Depending on the topic you select,
the topic will appear on your display or on your computer screen. When viewing screens other than Idle, the
Help button provides context sensitive help.

3 Red Eye Removal: Turns the Red Eye Removal feature on or off. By default, this feature is turned on.
When the feature is turned on, the HP Photosmart automatically corrects red eye coloring in the photos.
The Red Eye Removal light is solid green when the Red Eye Removal feature is on and a memory card
or storage device is present.

4 Setup: Opens the Setup menu on the display where you can generate reports, change device settings, and
perform maintenance functions.

5 Print Photos: Depending on whether you access your photos from the View, Print, or Create menu, the
Print Photos button will display the Print Preview screen or it will print any selected photos. If no photos
are selected, a prompt appears asking if you want to print all the photos on your card or storage device.

6 Cancel: Stops the current operation.

7 Attention light: Indicates a problem occurred. See the display for more information.

8 Back: Returns to the previous screen on the display.

9 Home: Launches the Photosmart Express menu on the display for viewing, printing, editing, and saving
your photos. You can also create special projects with your photos using the Photosmart Express menu.

10 Zoom out -: Zooms out to show more of a photo. If you press this button when a photo is shown on the
display at 100%, the Fit to Page feature is applied and the photo is scaled to fit the print size
automatically.

11 Zoom in +: Zooms in to enlarge the image on the display. You can also use this button together with the
arrows on the directional pad to adjust the crop box for printing.

12 OK: Selects a menu setting, value, or photo on the display.

13 Directional pad: Allows you to navigate through photos and menu options by pressing the up, down, left,
or right arrow buttons.
If you are zooming in on a photo, you can also use the arrow buttons to pan around the photo and select a
different area to print.

14 On: Turns the HP Photosmart on or off. The On light is solid blue when the product is on. The On light
flashes when the product is busy.

Control panel features 3
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Photosmart Express Menu
The following options are available in the Photosmart Express menu when you insert a memory card or press the
Home button on the control panel.

View

Print Create Save

• View: Lets you view, edit, and print photos on a memory card. For more information, see View and select
photos on page 8.

• Print: Lets you select a page layout and print your photos. For more information, see the onscreen Help. To
access the onscreen Help, see Find more information on page 12.

• Create: Lets you select a creative project (albums, panorama prints, passport photos, etc) for your photos. For
more information, see the onscreen Help. To access the onscreen Help, see Find more information
on page 12.

• Save: Lets you save photos from the memory card directly to the computer. For more information, see the
onscreen Help. To access the onscreen Help, see Find more information on page 12.

When you first display the Photosmart Express menu, View is highlighted by default. Press OK to select. To select
a different option, use the arrow keys on the directional pad to highlight the option, and then press OK.

TIP: Onscreen arrows appear next to the currently highlighted option to indicate the arrow keys that need to
be pressed to navigate to the other options.

Paper basics
The HP Photosmart printer supports paper sizes ranging from 7.6 x 12.7 cm to 33 x 111.8 cm (3 x 5 inches to
13 x 44 inches), including B+ (33 x 48.3 cm / 13 x 19 inch) paper, letter or A4 paper, legal paper, photo paper,
transparencies, and envelopes. By default, the HP Photosmart is set to detect the size and type of paper you load
in the input tray automatically and then adjust its settings to generate the highest quality output for that paper.

If you are using special papers, such as photo paper, transparency film, envelopes, or labels, or if you experience
poor print quality using the automatically-adjusted settings, you can manually set the paper size and type for print
jobs.

CAUTION: Do not load media thicker than 0.4 mm, as it can damage the product.

Choose the right paper
For a list of available HP inkjet paper, or to purchase supplies, go to:

• www.hpshopping.com (U.S.)
• www.hp.com/eur/hpoptions (Europe)
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• www.hp.com/jp/supply_inkjet (Japan)
• www.hp.com/paper (Asia/Pacific)

To get the best and longest-lasting results from the printer, choose from these high-quality HP photo papers.

To print Use this paper or media

High quality, long lasting prints and enlargements HP Advanced Photo paper (This paper is available in several
finishes, including glossy and satin-matt/soft gloss. Not all
finishes are available in all countries/regions or in every paper
size.)

Printhead alignment Plain paper

Casual photos from e-mail and the Web HP Everyday Photo paper or plain paper

Text documents, draft versions, and test pages Plain paper

Load the main tray
You can load many types of papers up to 33 x 111.8 cm (13 x 44 inches) into the main input tray of the HP Photosmart.

To load the main tray
1. Raise the output and photo trays together.

2. Extend the main tray to load large paper.

3. Slide the paper-width guide to its outermost position.

4. Make sure the product is idle and then insert the stack of paper into the main tray with the short edge forward
and the print side down. Slide the stack of paper in until it stops.

Paper basics 5
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TIP: If you are using letterhead, insert the top of the page first with the print side down.

5. Slide the paper-width guide inward until it stops at the edge of the paper.

NOTE: Make sure the paper stack is no higher than the paper-width guide.

6. Push in the main tray, if extended, to the edge of the paper stack.
7. Lower the photo and output trays together, and then extend the output tray.

Load the photo tray
You can load up to 13 x 18 cm (5 x 7 inch) photo paper into the photo tray of the HP Photosmart. For the best results,
use HP Advanced Photo Paper.

To load the photo tray
1. Raise the output tray.

2. Slide the paper-width guide to its outermost position.

3. Insert the stack of photo paper into the photo tray with the short edge forward and the print side down, sliding it
in until it stops.

TIP: Load tabbed photo paper so that the tabs feed in last.
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4. Slide the paper-width guide inward until it stops at the edge of the paper.

NOTE: Make sure the paper stack is no higher than the paper-width guide.

5. Lower the output tray.

Important! Make sure you lower the output tray completely, or the photo tray may not work correctly.

Avoid paper jams
To help avoid paper jams, follow these guidelines.

• Remove printed papers from the output tray frequently.
• Prevent curled or wrinkled photo paper by storing all unused photo paper flat in a resealable bag.
• Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.
• If you are printing labels, ensure that the label sheets are no more than two years old. Labels on older sheets

might peel off when the paper is pulled through the product, and cause paper jams.
• Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the input tray

must be the same size and type.
• Adjust the paper-width guide in the input tray to fit snugly against all paper. Make sure the paper-width guide

does not bend the paper in the input tray.
• Do not force paper too far forward in the input tray.
• Use paper types that are recommended for the product.

Print from memory cards and other devices
The HP Photosmart is equipped with memory card slots and a front USB port that enable you to print or edit photos
from a memory card or storage device (such as a keychain drive, portable hard drive, or a digital camera in storage
mode) without uploading your photos to a computer first. Additionally, if the HP Photosmart is connected to a
computer with a USB cable, you can also transfer your photos to the computer to print, or edit.

You can print photos by connecting a PictBridge-compatible digital camera directly to the front USB port. When you
print from a digital camera, the printer uses the settings that you selected on the camera. For more information, see
the documentation that came with the camera.

Print from memory cards and other devices 7
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Insert a memory card or storage device
The HP Photosmart supports memory cards and storage devices as described below. Each type of memory card
can only be inserted in the appropriate slot for that card, and only one card or storage device may be inserted at a
time.

CAUTION: Do not insert more than one memory card at a time. If more than one memory card is inserted,
unrecoverable data loss might occur.

1 Memory Stick, Memory Stick Pro, Memory Stick Select, Memory Stick Magic Gate, Memory Stick Duo or Duo Pro (adapter
optional), Memory Stick Micro (adapter required), or MS-HG

2 xD-Picture Card, xD- Picture Card type M, xD-Picture Card type H, Secure Digital (SD), Secure Digital Mini (adapter
required), SD micro (or Transflash), Secure Digital High Capacity (SDHC), MultiMediaCard (MMC), MultiMedia High-Density
(MMC-HD), MMC Plus, or MMC Mobile (RS-MMC; adapter required)

3 CompactFlash (CF) types I and II

NOTE: IBM Microdrive is not supported.

4 Photo light

5 Front USB port (for storage devices)

To insert a memory card or connect a photo storage device
1. Make sure the product is on.
2. Insert the memory card or connect the photo storage device to the front USB port.

The memory card area has a Photo light that flashes when the product is reading the memory card or storage
device. When the light becomes solid, you can view your photos.

CAUTION: Do not pull out the memory card while the Photo light is flashing. Doing so may damage the
memory card or the product.

NOTE: The product only recognizes the JPG and TIF file formats on your memory card or storage device.

View and select photos
You can view and select photos on your memory card or storage device before or while printing them.

To view and select photos
1. Load up to 13 x 18 cm (5 x 7 inch) photo paper in the photo tray or full-size photo paper in the main input tray.
2. Insert a memory card into the appropriate slot or connect a photo storage device to the front USB port.
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The Photosmart Express menu appears, with the most recent photo shown on the display and View
highlighted.

View

Print Create Save

3. Press OK to select View.
The View Photos screen appears.

4. Press  or  to scroll through the thumbnails of your photos.
5. When the thumbnail of the photo you want to view is highlighted, press OK.
6. When the photo appears by itself on the display, press OK again.

The Photo Options screen appears.
7. With Print Preview highlighted, press OK.

The Print Preview screen appears, showing how your photo will look when printed.
8. If you want to select additional photos to view and print, press  to highlight Add More, press OK, and repeat

steps 4-6.
Or, once you're in the Add Photos screen, the quickest way to select multiple photos (if you don't need the
option to edit them) is to press  to select a photo, and then press  or  to scroll through more photos to
select.

TIP: A checkmark appears to indicate each photo that is selected. You can change the number of copies
by pressing  or . The total number of photos that will print appears at the top of the display.

9. (Optional) If you want to check and/or modify any of your print settings, press  to highlight Settings and press
OK.

10. To print the photo(s), use  or  to highlight Print Now (or press the Print Photos button on the control panel).
A print status screen displays the number of pages to print and the estimated time to complete.

TIP: During printing, press OK to add more photos to the print queue.

Print your photos
You can print the photos on your memory card or photo storage device in a variety of sizes, from 8 x 13 cm (3 x 5
inch) up to the size of 33 x 48.3 cm (13 x 19 inch) paper, including multiple small-size photos on a single page.

To print your photos

TIP: To print a single borderless 10 x 15 cm (4 x 6 inch) photo on 10 x 15 cm (4 x 6 inch) paper, simply press
the Print Photos button on the control panel twice.

1. Load the paper.
• Load up to 13 x 18 cm (5 x 7 inch) photo paper in the photo tray.
• Load full-size photo paper in the main input tray.

2. Insert the memory card or connect the photo storage device.
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3. Make sure View is highlighted, and then press OK.
4. Use the arrow buttons to select a photo, and then press OK.
5. Press Print Photos on the control panel.
6. Follow the instructions on the printer display to modify the print settings:

• Select Print Now to print the photo immediately.
• Select Add More to change the number of copies.
• Select Settings to change the layout.

7. Press OK to print the photo.

Print photos from a PictBridge camera or other PictBridge device
This section describes the procedure for printing from a PictBridge digital camera. The procedure for printing from
other PictBridge devices—such as camera phones and other image capture devices—is very similar. Review the
documentation that came with your PictBridge device for specific information.

When you print from a digital camera, the printer uses the settings that you selected on the camera. For more
information, see the documentation that came with the camera.

PictBridge camera being connected to camera port

To print using a PictBridge-certified camera
1. Load photo paper in the printer.
2. Turn on the PictBridge-certified digital camera.
3. Make sure the USB configuration setting of the camera is set to Digital Camera, and then connect the camera

to the camera port of the printer using the USB cable that came with the PictBridge-certified camera. The Photo
light flashes green while the camera establishes a connection to the printer, and then turns solid green.
See the camera documentation for more information about the USB configuration setting. The name of the
setting and its options may differ on non-HP digital cameras.

4. If you already selected photos for printing on the camera, the Print DPOF Photos? dialog box is displayed on
the camera. DPOF (Digital Print Order Format) lets the user mark photos on a digital camera for printing and
include other image information, such as number of copies to be printed. Select Yes to print the pre-selected
photos, or select No to bypass printing pre-selected photos.

5. Use the options and controls on your camera to print your photos. See the camera documentation for more
information. The PictBridge light flashes while the photos are printing.

Print from your computer
The HP Photosmart can be used with any software application that allows printing. You can print a range of projects,
such as borderless images, newsletters, greeting cards, iron-on transfers, and posters.

Printing from a computer gives you more options for printing your images. Before printing from your computer, you
must install the HP Photosmart software and connect a USB cable from the printer (using the USB port on the back)
to your computer.

Print from a software application
To print from a software application (Windows)
1. Make sure you have paper loaded in the input tray.
2. On the File menu in your software application, click Print.
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3. Select the HP Photosmart as the printer.
If you set the HP Photosmart as the default printer, you can skip this step. The HP Photosmart will already be
selected.

4. If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties, Options, Printer Setup,
Printer, or Preferences.

NOTE: When printing a photo, you must select options for the specific photo paper and photo enhancement.

5. Select the appropriate options for your print job by using the features available in the Printing Shortcuts,
Features, Color, and Advanced tabs.

TIP: You can easily select the appropriate options for your print job by choosing one of the predefined print
tasks on the Printing Shortcuts tab. Click a type of print task in the Printing Shortcuts list. The default
settings for that type of print task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing shortcut. To save a custom
printing shortcut, select the shortcut and click Save As. To delete a shortcut, select the shortcut and click
Delete.

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.

To print from a software application (Mac OS X v10.4)
1. From the File menu in your software application, choose Page Setup.

The Page Setup dialog box appears, allowing you to specify the paper size, orientation, and scaling.
2. Make sure the HP Photosmart is the selected printer.
3. Specify the page attributes:

• Choose the paper size.
• Select the orientation.
• Enter the scaling percentage.

4. Click OK.
5. From the File menu in your software application, choose Print.

The Print dialog appears with the Copies & Pages pane open.
6. Change the print settings for each option in the pop-up menu, as appropriate for your project.

NOTE: When printing a photo, you must select options for the correct paper type and photo enhancement.

7. Click Print to begin printing.

To print from a software application (Mac OS X v10.5)
1. From the File menu in your software application, choose Print.

The Print dialog appears.
2. Make sure the HP Photosmart is the selected printer.
3. Click the blue disclosure triangle next to the Printer selection to access the print options.
4. Specify the page attributes:

• Choose the paper size.
• Select the orientation.
• Enter the scaling percentage.

5. To change other options, such as paper type, select them from the Application pop-up menu toward the bottom
of the dialog.

NOTE: When printing a photo, you must select options for the correct paper type and photo enhancement.

6. Click Print to begin printing.

Use the HP Solution Center
The HP Solution Center provides convenient access to many features of your HP device and software. Use the
HP Solution Center to learn about the printer and its software, and view troubleshooting solutions.

After you have installed the HP Photosmart software on a computer, open and explore the HP Solution Center:

Print from your computer 11
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▲ Right-click the HP Digital Imaging Monitor icon on the Windows taskbar, and then click Launch/Show
HP Solution Center.

You can also use the HP Solution Center to:

• Check printer status and access the printer Toolbox for maintenance utilities.
• Change printer settings.
• Order supplies.
• Start HP Photosmart software.
• Update your printer software.
• Access the HP Activity Center and HP Professional Photography Center Web sites.

For more information on using the HP Solution Center, see the onscreen Help.

You can also view informative How Do I? animations from the HP Solution Center:

▲ In the HP Solution Center, click Help, and then click Open Library in the Animations Library area.

Find more information
You can access a variety of resources, both printed and onscreen, that provide information about setting up and
using the HP Photosmart.

• Start Here guide: The Start Here guide provides instructions for setting up the HP Photosmart, including
printhead installation, ink cartridge insertion, paper loading, and software installation. Make sure you follow the
steps in the Start Here guide in order.
If you have problems during setup, check the Start Here guide for troubleshooting information, or see
Troubleshooting and support on page 17.

• HP Photosmart animations: The HP Photosmart animations, located in the relevant sections of the onscreen
Help, show you how to complete key tasks on the HP Photosmart. You will learn how to load paper, insert a
memory card, and replace ink.

• Help from your device: The Help menu on the display provides quick access to key help topics and is available
when you press the Help button. From the Idle state, pressing Help lists a menu of items for which help is
available. Depending on the topic you select, the topic will appear on your display or on your computer screen.
When viewing screens other than Idle, pressing Help provides context sensitive help.

• Onscreen Help: The onscreen Help provides detailed instructions on features of your HP Photosmart that are
not described in this guide, including features that are only available using the software you installed with your
HP Photosmart. The onscreen Help also provides regulatory and environmental information.
To access the onscreen Help
◦ Windows: Click Start > All Programs > HP > Photosmart B8500 series > Help.

To install the onscreen Help, insert the software CD in your computer and follow the onscreen instructions.
◦ Macintosh: Click Help > Mac Help > Library > HP Product Help.

• Readme: The Readme file contains the most recent information which might not be found in other publications.
Install the software to access the Readme file.

• HP Web site: If you have Internet access, you can get help and support from the HP Web site at www.hp.com/
support. This Web site offers technical support, drivers, supplies, and ordering information.
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2 Maintain the HP Photosmart
The HP Photosmart requires little maintenance. You might need to replace ink cartridges, clean the printhead, or
align the printer from time to time. This section provides instructions for keeping the HP Photosmart in top working
condition. Perform these simple maintenance procedures as necessary.

Work with ink cartridges and the printhead
To ensure the best print quality from the HP Photosmart, you will need to perform some simple maintenance
procedures and, when prompted by a message on the display, replace the ink cartridges.

Information on ink cartridges and the printhead
The following tips help maintain HP ink cartridges and ensure consistent print quality.

• Make sure you follow the instructions in the Start Here guide for installing the printhead and the ink cartridges
for the first time. For information on the ink cartridges used by this product, see the back cover of this guide.

• If you need to replace an ink cartridge, wait until you have the new ink cartridge available to install before
removing the old cartridge.

CAUTION: Wait until you have a new ink cartridge available before removing the old ink cartridge. Do not
leave the ink cartridge outside of the product for an extended period of time. This can result in damage to
both the product and the ink cartridge.

• Keep all ink cartridges in the original sealed packages until they are needed.
• Turn off the HP Photosmart by pressing the On button located on the product. Wait until the On light turns off

before unplugging the power cord or turning off a power strip. If you improperly turn off the HP Photosmart, the
print carriage might not return to the correct position causing problems with the ink cartridges and print quality
issues.

• Store ink cartridges at room temperature (15.6-26.6° C or 60-78° F).
• You do not need to replace the cartridges until print quality becomes unacceptable, but a significant decrease

in print quality may be the result of one or more depleted cartridges. It could also be caused by a clogged
printhead. Possible solutions include checking the estimated ink levels remaining in the cartridges, and cleaning
the printhead. Cleaning the printhead will use some ink.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the ink cartridges until print quality becomes unacceptable.

• Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.
• Handle ink cartridges carefully. Dropping, jarring, or rough handling during installation can cause temporary

printing problems.
• If you are transporting the product, do the following to prevent ink leaking from the print carriage or other damage

from occurring to the product:
◦ Make sure you turn off the product by pressing the On button.

The print carriage should be parked on the right side in the service station.
◦ Make sure you leave the ink cartridges and printhead installed.
◦ Lightly pack the inside of the product with crumpled newspaper to prevent the print carriage from moving

during transportation.
◦ The product must be transported sitting flat; it should not be placed its side, back, front, or top.

Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to replace an ink cartridge. The
ink supply level shows an estimate of the amount of ink remaining in the ink cartridges.

NOTE: 1 If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in another
printer, the ink level indicator might be inaccurate or unavailable.
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NOTE: 2 Ink level warnings and indicators provide estimates for planning purposes only. When you receive a
low-ink warning message, consider having a replacement cartridge available to avoid possible printing delays.
You do not need to replace the ink cartridges until print quality becomes unacceptable.

NOTE: 3 Ink from the cartridges is used in the printing process in a number of different ways, including in the
initialization process, which prepares the product and cartridges for printing, and in printhead servicing, which
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after it
is used. For more information, see www.hp.com/go/inkusage.

Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

To check the ink levels from the control panel
1. Press Setup.

2. Press the down arrow button to highlight Tools, and then press OK.
3. Press the down arrow button to highlight Display Ink Gauge, and then press OK.

The product displays a gauge that shows the estimated ink levels of all cartridges installed.

TIP: You can also print a diagnostic page to see if ink cartridges might need to be replaced.

Replace the ink cartridges
Follow these instructions when you need to replace ink cartridges.

NOTE: If you are setting up the product for the first time, make sure you follow the instructions in the Start Here
guide for installing the printhead and the ink cartridges.

If you do not already have replacement ink cartridges for the HP Photosmart, to order cartridges, go to www.hp.com/
buy/supplies. If prompted, choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.

NOTE: At this time, some portions of the HP Web site are available in English only.

CAUTION: Wait until you have a new ink cartridge available before removing the old ink cartridge. Do not leave
the ink cartridge outside of the product for an extended period of time. This can result in damage to both the
product and the ink cartridge.

To replace the ink cartridges
1. Make sure the product is turned on.
2. Open the ink cartridge access door.
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3. Wait until the print carriage stops moving. Press the tab on the front of the ink cartridge and remove the cartridge
from the slot.

4. Remove the plastic wrap from the new ink cartridge by pulling the orange pull-tab straight back.

NOTE: Make sure you remove the plastic wrap from the ink cartridge before installing it in the product, or
printing will fail.

5. Twist the orange cap to snap it off.

6. Slide the ink cartridge into its matching slot, and then press down firmly until it snaps into place.

CAUTION: Do not lift the latch handle on the print carriage when installing the ink cartridges.
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7. Repeat steps 3 through 6 for each ink cartridge you are replacing.
8. Close the ink cartridge access door.

Print a diagnostic page
If you are experiencing problems with printing, print a diagnostic page before you replace the ink cartridges. This
page provides useful information on several aspects of your product, including the ink cartridges.

To print a diagnostic page
1. Load letter, A4, or legal unused plain white paper into the main input tray.
2. Press the Setup button on the control panel.
3. Press  to highlight Tools, and then press OK.
4. Press  to highlight Diagnostic Page, and then press OK.

The product prints a diagnostic page, which contains the following information:
• Product information: includes the model number, serial number, and other product information.
• Revision information: includes the firmware version number.
• Ink delivery system information: displays the approximate ink level of each installed ink cartridge, the

status of each ink cartridge, the date each cartridge was installed, and the date each cartridge will expire.
• Print quality pattern: displays five color blocks, representing each of the five installed cartridges. Solid,

even blocks of color indicate there are no print quality problems. When streaks are displayed or there are
missing blocks, clean the printhead. If the color blocks still show print quality problems after cleaning the
printhead, align the printer. For more information on cleaning the printhead and aligning the printer, see the
onscreen Help. If the color blocks continue to show print quality problems after cleaning and aligning, contact
HP support.

• History log: contains information that might be used for diagnostic purposes if you need to call HP support.

Turn off the HP Photosmart
To avoid damaging the product, you must properly shut it down by using the On button located on the product. Wait
until the On light turns off before you unplug the power cord or turn off a power strip.
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3 Troubleshooting and support
This chapter contains troubleshooting information for the HP Photosmart. Specific information is provided for
installation and configuration issues, and some operational topics. For more troubleshooting information, see the
onscreen Help that came with your software. For more information on accessing the onscreen Help, see Find more
information on page 12.

Many issues are caused when the HP Photosmart is connected to the computer using a USB cable before the
HP Photosmart software is installed on the computer. If you connected the HP Photosmart to your computer before
the software installation screen prompts you to do so, you must follow these steps:

Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
3. Restart your computer.
4. Turn off the HP Photosmart, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

CAUTION: Do not connect the USB cable to the computer until prompted by the software installation screen.

For support contact information, see the inside back cover of this guide.

Uninstall and reinstall the software
If your installation is incomplete, or if you connected the USB cable to the computer before prompted by the software
installation screen, you might need to uninstall and then reinstall the software. Do not simply delete the
HP Photosmart application files from your computer. Make sure to remove them properly using the uninstall utility
provided when you installed the software that came with the HP Photosmart.

To uninstall and reinstall the software (Windows)
1. On the Windows taskbar, click Start, Settings, Control Panel (or just Control Panel).
2. Double-click Add/Remove Programs (or click Uninstall a program).
3. Remove all the items that are related to the HP Photosmart Software.

CAUTION: If the computer is manufactured by HP or Compaq, do not remove any applications other than
those listed below.

• HP Photosmart, Officejet, Deskjet (with the product name and software version number)
• HP Solution Center
• Shop for HP Supplies
• HP Update
• HP Imaging device functions
• HP Photosmart Essential
• HP Customer Participation Program
• HP Smart Web Printing
• Yahoo! Toolbar

4. Disconnect the product from your computer.
5. Restart your computer.

NOTE: It is important that you disconnect the product before restarting your computer. Do not connect the
product to your computer until after you have reinstalled the software.

6. Insert the product CD-ROM into your computer’s CD-ROM drive and then start the Setup program.

NOTE: 1 If the Setup program does not appear, locate the setup.exe file on the CD-ROM drive and double-
click it.

NOTE: 2 If you no longer have the installation CD, you can download the software from www.hp.com/
support.

7. Follow the onscreen instructions and the instructions provided in the Start Here guide that came with the product.
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When the software installation is complete, the HP Digital Imaging Monitor icon appears in the Windows system
tray.

To uninstall and reinstall the software (Mac)
1. Disconnect the HP Photosmart from your Mac.
2. Double-click the Applications:Hewlett-Packard folder.
3. Double-click HP Uninstaller.

Follow the onscreen instructions.
4. After the software is uninstalled, restart your computer, and then empty the Trash.
5. To reinstall the software, insert the HP Photosmart CD-ROM into your computer’s CD-ROM drive.
6. On the desktop, open the CD-ROM and then double-click HP Installer.
7. Follow the onscreen instructions and the printed setup instructions that came with the HP Photosmart.

Setup troubleshooting
This section contains setup troubleshooting information for the product.

The product will not turn on
Try the following solutions if there are no light indications, no noise, and no movement from the product when you
turn it on.

• Solution 1: Make sure you use the power cord that came with the product
• Solution 2: Reset the product
• Solution 3: Press the On button more slowly
• Solution 4: Contact HP to replace the power supply
• Solution 5: Contact HP support for service

Solution 1: Make sure you use the power cord that came with the product
Solution
• Make sure the power cord is firmly connected to both the product and the power adapter. Plug the power

cord into a power outlet, surge protector, or power strip.

1 Power connection

2 Power cord and adapter

3 Power outlet

• If you are using a power strip, make sure the power strip is turned on. Or, try plugging the product directly
into a power outlet.

• Test the power outlet to make sure it is working. Plug in an appliance that you know works, and see if the
appliance has power. If not, then there might be a problem with the power outlet.

• If you plugged the product into a switched outlet, make sure the outlet is switched on. If it is switched to on
but still does not work, then there might be a problem with the power outlet.

Cause: The product was not being used with the power cord provided.

If this did not solve the issue, try the next solution.
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Solution 2: Reset the product
Solution: Turn off the product and reset it by disconnecting the power cord. Wait 60 seconds, and then plug
in the power cord. Turn on the product.

Cause: The product experienced an error.

If this did not solve the issue, try the next solution.

Solution 3: Press the On button more slowly
Solution: The product might not respond if you press the On button too quickly. Press the On button once. It
might take a few minutes for the product to turn on. If you press the On button again during this time, you might
turn the product off.

CAUTION: If the product still does not turn on, it might have a mechanical failure. Unplug the product from
the power outlet.

Contact HP support for service.

Go to: www.hp.com/support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.

Cause: You pressed the On button too quickly.

If this did not solve the issue, try the next solution.

Solution 4: Contact HP to replace the power supply
Solution: Contact HP support to request a power supply for the product.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for information on calling for technical
support.

Cause: The power supply was not intended for use with this product.

If this did not solve the issue, try the next solution.

Solution 5: Contact HP support for service
Solution: If you have completed all of the steps provided in the previous solutions and are still having a
problem, contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for technical support.

Cause: You might need assistance to enable the product or software to function properly.

I connected the USB cable, but I am having problems using the product with my computer
Solution: You must first install the software that came with the product before connecting the USB cable.
During installation, do not plug in the USB cable until prompted by the onscreen instructions.

Once you have installed the software, connecting your computer to the product with a USB cable is
straightforward. Simply plug one end of the USB cable into the back of your computer and the other into the
back of the product. You can connect to any USB port on your computer.
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For more information on installing the software and connecting the USB cable, see the Start Here guide that
came with the product.

Cause: The USB cable was connected before the software was installed. Connecting the USB cable before
you are prompted can cause errors.

After setting up the product, it does not print
Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the
first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Check the connection between the product and computer
• Solution 2: Check that the ink cartridges are installed properly and have ink
• Solution 3: Press the On button to turn on the product
• Solution 4: Load paper in the input tray

Solution 1: Check the connection between the product and computer
Solution: Check the connection between the product and computer.

Cause: The product and computer were not communicating with each other.

If this did not solve the issue, try the next solution.

Solution 2: Check that the ink cartridges are installed properly and have ink
Solution: Check that the ink cartridges are installed properly and have ink.

For more information, see:

• Work with ink cartridges and the printhead on page 13

Cause: There might have been a problem with one or more of the ink cartridges.

If this did not solve the issue, try the next solution.

Solution 3: Press the On button to turn on the product
Solution: Look at the display on the product. If the display is blank and the On button is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged into a power outlet. Press
the On button to turn on the product.

Cause: The product might not have been turned on.

If this did not solve the issue, try the next solution.
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Solution 4: Load paper in the input tray
Solution: Load paper in the input tray.

For more information, see:

• Paper basics on page 4

Cause: The product might have been out of paper.

When I insert the CD-ROM into my computer’s CD-ROM drive, nothing happens
Solution: If the installation does not run automatically, you can start it manually.

To start the installation from a Windows computer
1. From the Windows Start menu, click Run (or click Accessories, and then Run).
2. In the Run dialog box, enter d:\setup.exe, and then click OK.

If your CD-ROM drive is not assigned to drive letter D, enter the appropriate drive letter.

Cause: The installation failed to run automatically.

The Minimum System Checks screen appears
Solution: Click Details to see what the specific problem is, and then correct the problem before attempting
to install the software.

Cause: Your system did not meet the minimum requirements to install the software.

A red X appears on the USB connect prompt
Solution: Check that the product is turned on, and then try the USB connection again.

To retry the USB connection
1. Verify that the USB cable is set up properly as follows:

• Unplug the USB cable and plug it in again or try plugging the USB cable into a different USB port.
• Do not attach the USB cable to a keyboard.
• Verify that the USB cable is 3 meters (9.8  feet) or less in length.
• If you have several USB devices attached to your computer, you might want to unplug the other devices

during the installation.
2. Unplug the product power cord, and then plug it in again.
3. Verify that the USB cable and power cord are plugged in.

4. Click Retry to retry the connection.
5. Continue with the installation and restart the computer when prompted.

Cause: The USB connection between the product and the computer failed.

Setup troubleshooting 21

En
gl

is
h



Clear paper jams
In case of a paper jam, check the rear door. You might need to clear the paper jam from the rear door.

To clear a paper jam from the rear door
1. Remove the door by pulling it away from the product.

2. Gently pull the paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and wheels for
torn pieces of paper that might be remaining inside the product. If you do not remove all the pieces of paper
from the product, more paper jams are likely to occur.

3. Replace the rear door. Gently push the door forward until it snaps into place.

4. Press OK on the control panel to continue the current job.

Print troubleshooting
Use this section to solve these printing problems.

The product is not responding
Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the
first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Turn on the product
• Solution 2: Load paper in the input tray
• Solution 3: Select the correct printer
• Solution 4: Check the printer driver status
• Solution 5: Wait until the product completes the current operation
• Solution 6: Remove all cancelled print jobs from the queue
• Solution 7: Clear the paper jam
• Solution 8: Make sure the print carriage can move freely
• Solution 9: Check the connection from the product to your computer
• Solution 10: Reset the product

Solution 1: Turn on the product
Solution: Look at the On light located on the product. If it is not lit, the product is turned off. Make sure the
power cord is firmly connected to the product and plugged into a power outlet. Press the On button to turn on
the product.

Cause: The product was turned off.

If this did not solve the issue, try the next solution.

Chapter 3

22 Troubleshooting and support

English



Solution 2: Load paper in the input tray
Solution: Load paper in the input tray.

For more information, see:

• Paper basics on page 4

Cause: The product was out of paper.

If this did not solve the issue, try the next solution.

Solution 3: Select the correct printer
Solution: Make sure you have selected the correct printer in your software application.

TIP: You can set the product as the default printer to ensure that the printer is automatically selected when
you select Print in the File menu of your different software applications.

Cause: The product was not the selected printer.

If this did not solve the issue, try the next solution.

Solution 4: Check the printer driver status
Solution: The printer driver status might have changed to either offline or stop printing.

To check the printer driver status (Windows)
▲ Open the HP Solution Center. Make sure the product is the selected printer. For information on opening the

HP Solution Center, see Use the HP Solution Center on page 11.
Click the Status icon at the bottom of the HP Solution Center window.

To check the printer driver status (Mac OS X v10.4)
1. From the Finder, select Applications:Utilities, then double-click Printer Setup Utility.
2. Double-click the printer name to open the print queue.
3. Click a print job to select it.

Use the following buttons to manage the print job:
• Delete: Cancel the selected print job.
• Hold: Pause the selected print job.
• Resume: Continue a paused print job.
• Stop Jobs: Pause all print jobs in the print queue.

To check the printer driver status (Mac OS X v10.5)
1. In System Preferences, click Print & Fax.
2. Click the Open Print Queue button.
3. Click a print job to select it.

Use the following buttons to manage the print job:
• Delete: Cancel the selected print job.
• Hold: Pause the selected print job.
• Resume: Continue a paused print job.
• Pause Printer: Pause all print jobs in the print queue.

Cause: The status of the printer driver had changed.

If this did not solve the issue, try the next solution.

Solution 5: Wait until the product completes the current operation
Solution: If the product is performing another task such as printing a photo or performing printer maintenance,
your print job will be delayed until the product completes the current task.

Some documents take a long time to print. If nothing has printed several minutes after you sent a print job to
the product, check the product display to see if there are any messages.

Cause: The product was busy with another task.
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If this did not solve the issue, try the next solution.

Solution 6: Remove all cancelled print jobs from the queue
Solution: A print job might remain in the queue after it has been cancelled. The cancelled print job jams the
queue and prevents the next print job from printing.

To delete a print job (Windows)
1. On the Windows taskbar, click Start, and then click Control Panel.
2. Click Printers (or double-click Printers and Faxes).

NOTE: In Windows Vista, you may need to select Hardware and Sound first if your Control Panel is
not set to Classic View.

3. Double-click the product icon.

TIP: You can also double-click the printer icon in the Windows taskbar.

4. Select the print job you want to cancel.
5. On the Document menu, click Cancel Printing or Cancel, or press the Delete key on your keyboard.

It can take a few moments for the print job to be cancelled.

If the print job remains in the queue, try one or both of the following:

• Disconnect the USB cable from the product, restart the computer, and then reconnect the USB cable to the
product.

• Shut down the product, restart the computer, and then restart the product.

To delete a print job (Mac OS X v10.4)
1. From the Finder, select Applications:Utilities, then double-click Printer Setup Utility.
2. Double-click the printer name to open the print queue.
3. Click a print job to select it.
4. Click Delete.

To delete a print job (Mac OS X v10.5)
1. In System Preferences, click Print & Fax.
2. Click the Open Print Queue button.
3. Click a print job to select it.
4. Click Delete.

Cause: A deleted print job was in the queue.

If this did not solve the issue, try the next solution.

Solution 7: Clear the paper jam
Solution: Clear the paper jam.

Cause: The product had a paper jam.

If this did not solve the issue, try the next solution.

Solution 8: Make sure the print carriage can move freely
Solution: Unplug the power cable if it is not already unplugged. Check to see if the print carriage will move
freely from one side of the printer to the other. Do not try to force it to move if it is hung up on something.

CAUTION: Be careful not to force the print cartridge carriage. If the carriage is stuck, forcing it to move will
damage the printer.

Cause: The print carriage had stalled.

If this did not solve the issue, try the next solution.
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Solution 9: Check the connection from the product to your computer
Solution: Check the connection from the product to your computer. Verify that the USB cable is securely
plugged into the USB port on the back of the product. Make sure the other end of the USB cable is plugged into
a USB port on your computer. After the cable is connected properly, turn off the product and then on again.

If the connections are secure, and nothing has printed several minutes after you sent a print job to the product,
check the status of the product.

Cause: The computer was not communicating with the product.

If this did not solve the issue, try the next solution.

Solution 10: Reset the product
Solution: Turn off the product and reset it by disconnecting the power cord. Wait 60 seconds, and then plug
in the power cord. Turn on the product.

Cause: The product experienced an error.

Paper is not picked up from the input tray
Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the
first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Reset the product
• Solution 2: Make sure the paper is loaded correctly
• Solution 3: Check the print settings
• Solution 4: Clean the rollers
• Solution 5: Service the product

Solution 1: Reset the product
Solution: Turn off the product and reset it by disconnecting the power cord. Wait 60 seconds, and then plug
in the power cord. Turn on the product.

Cause: The product experienced an error.

If this did not solve the issue, try the next solution.

Solution 2: Make sure the paper is loaded correctly
Solution: Make sure that the paper is loaded correctly in the input tray.

For more information, see:

• Paper basics on page 4

Cause: The paper was not loaded correctly.
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If this did not solve the issue, try the next solution.

Solution 3: Check the print settings
Solution: Check the print settings.
• Check the paper type setting to make sure it matches the type of paper loaded in the input tray.
• If you are printing from a computer, make sure the Paper Source (Windows) or Source (Mac) setting in the

printer driver is set to the correct paper tray.

For more information, see the onscreen Help.

Cause: The paper type or print quality settings were set incorrectly.

If this did not solve the issue, try the next solution.

Solution 4: Clean the rollers
Solution: Clean the rollers.

Make sure you have the following materials available:

• A lint-free cloth, or any soft material that will not come apart or leave fibers.
• Distilled, filtered, or bottled water (tap water might contain contaminants that can damage the print

cartridges).

To clean the rollers
1. Turn off the product and remove the power cord.
2. Remove the rear door by pulling the left side of the door away from the product.

3. Dip the lint-free cloth into the purified or distilled water, and squeeze any excess water from it.
4. Clean the rubber rollers to remove any dust or dirt buildup.
5. Replace the rear door. Gently push the door forward until it snaps into place.
6. Plug the power cord back in, and turn on the product.
7. Try to print again.

Cause: The rollers were dirty and needed to be cleaned.

If this did not solve the issue, try the next solution.

Solution 5: Service the product
Solution: If you have completed all of the steps provided in the previous solutions, contact HP support for
service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for information on calling for technical
support.

Cause: Your product needs servicing.

The product prints meaningless characters
Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the
first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Reset the product
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• Solution 2: Print a previously saved version of the document

Solution 1: Reset the product
Solution: Turn off the product and reset it by disconnecting the power cord. Wait 60 seconds, and then plug
in the power cord. Turn on the product.

Cause: There was no available memory in the product.

If this did not solve the issue, try the next solution.

Solution 2: Print a previously saved version of the document
Solution: Try printing another document from the same software application. If this works, then try printing a
previously saved version of the document that is not corrupt.

Cause: The document was corrupt.

The pages in my document came out in the wrong order
Solution: Print the document in reverse order. When the document finishes printing, the pages will be in correct
order.

Cause: The print settings were set to print the first page of your document first. Because of the way the paper
feeds through the product, the first page will be print side up at the bottom of the stack.

Text or graphics are cut off at the edge of the page
Try the following solutions to resolve the issue. Solutions are listed in order, with the most likely solution first. If the
first solution does not solve the problem, continue trying the remaining solutions until the issue is resolved.

• Solution 1: Check the margin settings
• Solution 2: Check the layout of the document
• Solution 3: Load the stack of papers correctly
• Solution 4: Try printing with borders

Solution 1: Check the margin settings
Solution: Make sure the margin settings for the document do not exceed the printable area of the product.

To check your margin settings
1. Preview your print job before sending it to the product.

In most software applications, click the File menu, and then click Print Preview.
2. Check the margins.

The product uses the margins you have set in your software application, as long as they are greater than
the minimum margins the product supports. For more information about setting margins in your software
application, see the documentation that came with the software.

3. Cancel the print job if the margins are not satisfactory, and then adjust the margins in your software
application.

Cause: The margins were not set correctly in your software application.

If this did not solve the issue, try the next solution.

Solution 2: Check the layout of the document
Solution: Make sure the layout of the document you are trying to print fits on a paper size supported by the
product.

To preview the print layout (Windows)
1. Load the correct paper size into the input tray.
2. Preview your print job before sending it to the product.

In most software applications, click the File menu, and then click Print Preview.
3. Check the graphics in the document to make sure that the current size fits within the printable area of the

product.
4. Cancel the print job if the graphics do not fit in the printable area of the page.
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To preview the print layout (Mac)
1. Load the correct paper size into the input tray.
2. Open the Printer dialog.
3. OS X v10.5: Click the blue disclosure triangle next to the Printer selection to access the print options.
4. OS X v10.5 A preview of the document is displayed in the left side of the dialog.
5. OS X v10.4 Click Preview.

A preview of the printed document is displayed.
6. Do one of the following:

• Click Print to print the document.
• Click Cancel to cancel the print job. Adjust the print settings as needed before trying to print the document

again.

TIP: Some software applications allow you to scale the document to fit the paper size currently selected.
Additionally, you can scale the size of a document from the print Properties dialog box.

Cause: The size of the document you were printing was larger than the paper loaded in the input tray.

If this did not solve the issue, try the next solution.

Solution 3: Load the stack of papers correctly
Solution: If the paper is misfeeding, it could cause parts of the document to cut off.

Remove the stack of paper from the input tray, and then reload the paper.

For more information, see:

• Paper basics on page 4

Cause: The paper was loaded incorrectly.

If this did not solve the issue, try the next solution.

Solution 4: Try printing with borders
Solution: Try printing with borders by turning off the borderless option.

Cause: Borderless printing was enabled. By selecting the Borderless option, your printed photo was enlarged
and centered to fit the printable area of the page. Depending on the relative sizes of the digital photo and the
paper on which you are printing, this could result in some parts of the image being cropped.

Ink is spraying the inside of the product when I print a photo
Solution: Make sure you load photo paper in the input tray before you print a borderless print job.

Cause: You were using the wrong paper type. The borderless print settings require you to print on photo paper.

The product prints slowly
Try the following solutions if the product is printing very slowly.

• Solution 1: Use a lower print quality setting
• Solution 2: Check the ink levels
• Solution 3: Contact HP support

Solution 1: Use a lower print quality setting
Solution: Check the print quality setting. Best and Maximum dpi provide the best quality but are slower than
Normal or Draft. Draft provides the fastest print speed.

For more information, see the onscreen Help.

Cause: The print quality was set to a high setting.

If this did not solve the issue, try the next solution.

Chapter 3

28 Troubleshooting and support

English



Solution 2: Check the ink levels
Solution: Check the estimated ink levels in the ink cartridges. Insufficient ink may cause the printhead to
overheat. When the printhead overheats, the printer slows down to allow it to cool.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive
a low-ink warning message, consider having a replacement cartridge available to avoid possible printing
delays. You do not need to replace the ink cartridges until print quality becomes unacceptable.

For more information, see:

• Check the estimated ink levels on page 13

Cause: The ink cartridges might have insufficient ink.

If this did not solve the issue, try the next solution.

Solution 3: Contact HP support
Solution: Contact HP support for service.

Go to: www.hp.com/support.

If prompted, choose your country/region, and then click Contact HP for information on calling for technical
support.

Cause: There was a problem with the product.

Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is available to all HP customers.

It is the fastest source for up-to-date device information and expert assistance and includes the following
features:
• Fast access to qualified online support specialists
• Software and driver updates for the product
• Valuable product and troubleshooting information for common problems
• Proactive device updates, support alerts, and HP newsgrams that are available when you register the

product
3. Call HP support. Support options and availability vary by device, country/region, and language.

For a list of support phone numbers, see the inside back cover of this guide.

Support process 29

En
gl

is
h

http://h20180.www2.hp.com/apps/Nav?h_pagetype=S-001&h_lang=en&h_cc=us&h_product=3542174&h_page=hpcom&h_client=s-h-m002-1
http://h20180.www2.hp.com/apps/Nav?h_pagetype=S-001&h_lang=en&h_cc=us&h_product=3542174&h_page=hpcom&h_client=s-h-m002-1


4 Technical information
The technical specifications and international regulatory information for the HP Photosmart are provided in this
section.

For additional regulatory and environmental information, including the Declaration of Conformity statement, see the
onscreen Help.

System requirements
The table below lists the minimum requirements the computer must have to work with the printer.

Component Windows Mac

Operating
system

Microsoft® Windows XP or Vista (32-bit or 64-bit)

NOTE: Limited printer software functionality,
consisting of a print driver and the printer Toolbox
application only, is available for Windows XP x64
Edition.

Mac OS X v10.4, v10.5

Processor A modern 1 GHz 32-bit or 64-bit processor (2 GHz or
higher recommended)

PowerPC with G3, G4, G5, or Intel Core-based
processors

RAM For Windows XP and Windows Vista Home edition:
512 MB (1GB or higher recommended)
All other versions of Windows Vista: 1 GB (2 GB or
higher recommended)

256 MB (512 MB recommended)

Free disk
space

For Windows XP: 800 MB
For Windows Vista: 1.5 GB

500 MB

Video
display

SVGA 800 x 600 monitor with 16-bit color (SVGA 1024
x 768 monitor with 32-bit color recommended)

1024 x 720 monitor

CD-ROM or
DVD-ROM
drive

Required Required

USB USB port and USB cable (cable not included) USB port and USB cable (cable not included)

Internet
access

Recommended Recommended

Software Required: Microsoft Internet Explorer 6 or higher
Recommended: Adobe Acrobat Reader 5 or higher

Any browser

Product specifications
For product specifications, go to the HP Web site at www.hp.com/support.

Paper specifications
• Main input tray capacity: Plain paper sheets: Up to 125, Photo paper sheets: Up to 40
• Output tray capacity: Plain paper sheets: Up to 50, Photo paper sheets: Up to 25
• Photo tray capacity: Photo paper sheets: Up to 20

NOTE: For a complete list of supported media sizes, see the printer software.

Physical specifications
• Height: 184 mm (7.25 inches)
• Width: 578 mm (22.75 inches)
• Depth: 394 mm (15.5 inches)
• Weight: 7.5 kg (16.6 lbs)
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Power specifications
• Power consumption (average): 14 W (Printing); 3 W (Idle); 0.48 W (Off)
• Power supply model number: 0957-2230
• Power adapter input rating: AC 100 to 240 V 50-60 Hz
• Power adapter output rating: DC 32 V

NOTE: Use only with the power adapter supplied by HP.

Environmental specifications
• Recommended operating temperature range: 15 ºC to 35 ºC (59 ºF to 95 ºF)
• Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)
• Humidity: 20% to 80% RH (recommended); 5% to 99% RH (maximum)
• Non-operating (Storage) temperature range: -30 ºC to 65 ºC (-22 ºF to 149 ºF)
• In the presence of high electromagnetic fields, it is possible the output from the HP Photosmart may be slightly

distorted
• HP recommends using a USB cable less than or equal to 3 meters (10 feet) in length to minimize injected noise

due to potential high electromagnetic fields

Regulatory notices
The HP Photosmart meets product requirements from regulatory agencies in your country/region. For a complete
listing of regulatory notices, see the onscreen Help.

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory Model
Number for your product is SDGOA-0821. This regulatory number should not be confused with the marketing name
(HP Photosmart B8500 series, etc.) or product numbers (CB981A, etc.).

Environmental product stewardship program
For Environmental product stewardship program information, see the onscreen Help that came with your software.
For more information on accessing the onscreen Help, see Find more information on page 12.

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our products as
needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This warranty
does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of warranty
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date has not been reached. The end of warranty date, in YYYY/MM/DD format, may be found on the product as
indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that came with the product.

http://www.hp.com/go/reach
http://www.hp.com/go/reach
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